IBM WebSphere Development Studio Client for iSeries

The IBM Webkacing Tool

Version 6.0

<|ll






IBM WebSphere Development Studio Client for iSeries

The IBM Webkacing Tool

Version 6.0

<|ll



ii Development Studio Client: IBM WebFacing Tool



Contents

Introduction. . . . . . . . . . . . .V

Chapter 1. Module 1. Reviewing the 5250
order entry application ..
Exercise 1.1: Starting the 5250 application.
Exercise 1.2: Accessing the online help.
Exercise 1.3: Selecting a customer

Exercise 1.4: Filling the order .

Exercise 1.5: Completing the order .

N O R NN =,

Chapter 2. Module 2. Creating the

WebFacing project . . . . . . . . . .9
Exercise 2.1: Starting the product . . . . 10
Exercise 2.2: Opening the WebFacing perspectlve .11
Exercise 2.3: Starting the WebFacing Web Project

wizard . . . . .. .13
Exercise 2.4: Selectmg dlsplay ﬁle members to

convert. . . . .14
Exercise 2.5: Spec1fy1ng the CL Command to launch

the application . . B 1)
Exercise 2.6: Selecting a Web style .o .21
Exercise 2.7: Completmg the WebFacmg pro]ect
information . . . . .22

Chapter 3. Module 3. Converting
selected source members . . . . . . 27
Exercise 3.1: Selecting the project and source

members . . . ... 27
Exercise 3.2: Startmg the WebFacmg conversion . . 29
Exercise 3.3: Checking the conversion logs . . . . 31

Chapter 4. Module 4. Running the
WebFacing application. . . . . . . . 33

Exercise 4.1: Showing the indexjsp page. . . . .34
Exercise 4.2: Testing the WebFacing application . . 36
Exercise 4.3: Testing the help support. . . . . .39

Chapter 5. Module 5. Changing the

user interface. . . . .4
Exercise 5.1: Opening DDS dlsplay f11e source in

CODE Designer . . . .42
Exercise 5.2: Applying Web Settmgs in CODE

Designer . . .42
Exercise 5.3: Openlng DDS dlsplay f11e source in the
LPEX Editor . . . . 49
Exercise 5.4: Applying Web Settmgs in the LPEX

Editor . . . -
Exercise 5.5: Testlng the changed apphcatlon .. .60

Chapter 6. Module 6. Changing the

style of the Web user interface . . . . 63
Exercise 6.1: Changmg the rules for hlghhghted
fields . . . . . . .63

© Copyright IBM Corp. 2001, 2005

Exercise 6.2: Changing styles directly. . . . . .66
Exercise 6.3: Testing the changed application . . . 70

Chapter 7. Module 7. Adding command

key rulesandlabels. . . . . . . . .73
Exercise 7.1: Adding a new command key

description pattern . . . .74
Exercise 7.2: Adding command key button labels .77

Chapter 8. Module 8. Working with

more style properties . . . . . 81
Exercise 8.1: Starting the WebFacmg propertles style
dialog . . . B 1

Exercise 8.2: Changmg the appearance of the subfile 83
Exercise 8.3: Customizing the appearance of

command keys . . . .. . .. .85
Exercise 8.4: Checking the new style ... .. .86

Chapter 9. Module 9. Customlzmg the

default style . . . . . . . . 89
Exercise 9.1: Opening Pagebullder jsp- - . . . .90
Exercise 9.2: Importing the company logo . . . .91
Exercise 9.3: Editing the style sheet and

PageBuilderjsp . . . . . . . . . . . . .92

Chapter 10. Module 10. Adding

authentication . . . . 97
Exercise 10.1: Removing the default user ID and

password . . . . .97
Exercise 10.2: Testing the authentlcatlon dlalog .99

Chapter 11. Module 11. Enhancmg

index.jsp page . . . . . . . 101
Exercise 11.1: Opening Page Des1gner B (1)
Exercise 11.2: Working with page properties . . . 103
Exercise 11.3: Linking a cascading style sheet to a

Web page. . . . . . . . . . . . . . .104
Exercise 11.4: Designing and adding a logo . . . 106
Exercise 11.5: Adding a heading 1 tag to the page 115
Exercise 11.6: Adding a picture to the page . . . 117
Exercise 11.7: Adding moving text to the page . . 118
Exercise 11.8: Changing the text color . . . . 124

Exercise 11.9: Deleting default text from the page 125

Chapter 12. Module 12. (Optional)
Exporting to iSeries WebSphere
Application Server Express 6 . . . . 127

Exercise 12.1: Mapping a network drive . . . . 127
Exercise 12.2: Exporting your EAR file . . . . . 128
Exercise 12.3: Installing the application. . . . 130
Exercise 12.4: Testing the WebFacing apphcatlon 136
Chapter 13. Summary. . . . . . . . 139

iii



Appendix. Notices . . . . . . . . . 141 Trademarks . . . . . . . . . . . . . .143
Programming interface information . . . . . . 142

iv Development Studio Client: IBM WebFacing Tool



Introduction

This tutorial teaches you how to convert the DDS screens in an existing 5250 order
entry application to a Web browser user interface. While creating a browser user
interface, you will learn how to use the IBM® WebFacing Tool. You will also learn
how to customize the output of the conversion process using the IBM WebFacing
Tool and the CODE Designer. Next, you will learn how to run the WebFacing
application in the WebSphere® Test Environment that is part of the product. You
will also learn how to use Page Designer to customize the application start page
and you will learn how to publish and deploy your WebFacing application to a
remote WebSphere Application Server (this is an optional module).

Prerequisites

In order to complete this tutorial end to end, you should already have working
knowledge of the following:

* Basic Microsoft® Windows® operations such as working with the desktop and
basic mouse operations such as opening folders and performing drag-and-drop
operations

* How Web applications work

* How to use a browser to navigate the Internet

It is also useful, but not necessary, for you to have basic knowledge of the
following:

* DDS

* Servlets and Java = Server Pages (to understand the generated output of the
WebFacing Tool)

Time required

To complete the modules of this tutorial, you will need approximately 3 hours and
15 minutes.

Learning objectives
This tutorial is divided into twelve modules, each with its own learning objectives.

You can choose to complete one or all of the modules. Each module contains
several exercises that must be completed in order for the tutorial to work properly.

[Chapter 1, “Module 1. Reviewing the 5250 order entry application,” on page 1|
teaches you about the 5250 order entry application before you start and use the
WebFacing Tool to convert it. In this module, you will:

* Start a 5250 emulation session

* Call the order entry application

* View the customer selection screen

* Display help for the customer number field

* Display help for selecting a customer

 Display help for specifying a valid customer number
* Display extended help for the customer number field
* Display the customer selection list
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* Select a customer from the list
* Display the parts selection list
* Select a part from the list

* Specify the part quantity

* Accept the order

* Exit the application

[Chapter 2, “Module 2. Creating the WebFacing project,” on page 9| teaches you
how to create a WebFacing project. In this module, you will:

e Start the product

* Set the default workspace

* Access unique views and tools targeted towards the WebFacing tasks
* Specify a name for your WebFacing Web Project

+ Connect to an iSeries” server

* Select DDS source members to convert

¢ Select UIM source members to convert

* Specify the CL command to invoke the application

* Specify the application signon values

* Select a Web style for your converted application

* Create the WebFacing Web Project without converting files

[Chapter 3, “Module 3. Converting selected source members,” on page 27 teaches
you how to convert one or more DDS and UIM files. In this module, you will:

* Select members to convert

* Convert members

¢ Check reference keywords for errors

* Check the DSPF conversion log for errors

¢ Check the UIM conversion log for errors

[Chapter 4, “Module 4. Running the WebFacing application,” on page 33| teaches
you how to run the Web application in the WebSphere Test Environment. In this
module, you will:

* Set the WebSphere Test Environment to test the application locally
* Launch the WebFacing application

* Prompt for a customer

* Select a customer from a list of customers

¢ Prompt for a part

* Select a part from a list of parts

* Enter a quantity for a part

* Display help for the customer selection list

[Chapter 5, “Module 5. Changing the user interface,” on page 41| teaches you how
to change certain aspects of the user interface related to the conversion process. In
this module, you will:

* Locate a DDS source member

* Open a DDS source member with CODE Designer
— Create a hyperlink action for the option field
— Hide the option field

Development Studio Client: IBM WebFacing Tool



— Hide the option heading for the option field
Hide the select instruction

Change the appearance of text

Close CODE Designer

Open a DDS source member with the LPEX Editor
— Create a hyperlink action for the option field

- Hide the option field

— Hide the option heading for the option field

— Add a new WebFacing class and change a headings location
— Hide the select instruction

— Change the appearance of text

— Close the LPEX Editor

Reconvert the DDS source members

Launch the reconverted WebFacing application

Prompt for a customer and part

Verify the changes in the customer selection window and the part selection
window

[Chapter 6, “Module 6. Changing the style of the Web user interface,” on page 63

teaches you how to create a new style, change style settings, specify the new style
to be used for the project and refresh the project with the new style. In this
module, you will:

Start the Style Properties dialog

Change the DDS Field Display Attributes
Locate the cascading style sheet file

Edit the cascading style sheet file

Check the new styles

[Chapter 7, “Module 7. Adding command key rules and labels,” on page 73 teaches

you how to add your own command key recognition rules to the WebFacing
conversion properties. In this module, you will:

Start the Properties dialog

Select Command Key Recognition Patterns
Add a new command key rule

Reconvert the DDS members

Test the applied new rule

Change the text for the F12 command key
Reconvert the DDS members

Test the new command key label

[Chapter 8, “Module 8. Working with more style properties,” on page 81| teaches

you how to apply changes to windows, the look of push buttons, and subfiles. In
this module, you will:

Start the Properties dialog
Change the window style
Change the subfile style
Change the command key style
Test the changed properties
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[Chapter 9, “Module 9. Customizing the default style,” on page 89| teaches you how
to customize that style, updating the look and feel for a fictional company. In this
module, you will:

* Locate the existing style

* View the design of the existing style

e Import the company logo

* Edit the style sheet to include the company logo

* Edit PageBuilder.jsp to remove and resize fields for your logo
* Change the color

[Chapter 10, “Module 10. Adding authentication,” on page 97| teaches you how to
secure your application by forcing authentication before the application is called. In
this module, you will:

e Start the Properties dialog

* Open the project run-time properties

* Change the signon properties for the order entry application
* Test the signon dialog appears

[Chapter 11, “Module 11. Enhancing index.jsp page,” on page 101| teaches you how
to take the plain index.jsp page generated by the WebFacing Tool and add color
and some pictures to make the input page of the Web application more interesting.
In this module, you will:

* Open index.jsp in Page Designer

* Change the window title to Order Entry

* Add a style to the Order Entry Web page

* Start WebArt Designer

* Add a logo

* Resize the logo

* Save the logo as a WebArt object

* Save the logo for a Web page

* Place the logo on the Design page

* Insert a heading below the logo

* Add a picture to the Order Entry Web page

e Add a marquee to the Order Entry Web page
* Change the color of the window title

* Remove default text added by the WebFacing Tool

Chapter 12, “Module 12. (Optional) Exporting to iSeries WebSphere Application|
Server Express 6,” on page 127] teaches you how to export files created by the
WebFacing Tool to a remote WebSphere Application Server, to publish and deploy
your application as you would when your application is ready for production. In
this module, you will:

* Map a network drive

* Open the Export wizard

e Export the EAR file

* Start an existing HTTP server console

When you are ready, begin [Chapter 1, “Module 1. Reviewing the 5250 order entry]|
lapplication,” on page 1.
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Chapter 1. Module 1. Reviewing the 5250 order entry
application

This module teaches you how the existing application green screens, command
keys and help panels work and look before you start using the WebFacing Tool to
convert it. You will become familiar with the 5250 screens and the behavior of the
application so that after conversion with the WebFacing Tool you will then be able
to compare the 5250 and the Web user interface.

Completing this module will also test your user profile setup. If you can run this
application directly without changing the job environment on the iSeries, the
WebFacing conversion and the WebFacing server will not have problems during
the remaining exercises later.

You will use a 5250 emulation screen to start the sample Order Entry application.
You will be prompted with the first screen for a customer number. You will work
with the help panels this application provides. You will select a customer from the
list of valid customers and then go through the steps of filling an order by
specifying the quantity ordered. After all parts and their quantities for this order
have been specified you complete the order by pressing a specific command key.
The application will then prompt you for a new customer number to handle the
next order.

Note: If you have problems make sure the library list for your job is setup
correctly to include library WFLABXX at job start up.

In this module, you will:

e Start a 5250 emulation session

* Call the order entry application

e View the customer selection screen

* Display help for the customer number field

* Display help for selecting a customer

 Display help for specifying a valid customer number
 Display extended help for the customer number field
* Display the customer selection list

* Select a customer from the list

* Display the parts selection list

* Select a part from the list

* Specify the part quantity

* Accept the order

¢ Exit the application

Requirement: Before beginning this module, you should have the prerequisite
knowledge outlined in [“Introduction” on page v

Exercises

The exercises within this module must be completed in order:

* |“Exercise 1.1: Starting the 5250 application” on page 2|

© Copyright IBM Corp. 2001, 2005 1



[“Exercise 1.2: Accessing the online help”]

[“Exercise 1.3: Selecting a customer” on page 4|

[“Exercise 1.4: Filling the order” on page 6|

[“Exercise 1.5: Completing the order” on page 7|

Time required

This module will take approximately 5 minutes to complete.

Exercise 1.1: Starting the 5250 application

You need a 5250 emulator on your workstation to start the order entry application.

To start the 5250 application:

1.

You have started a 5250 emulation session, invoked the order entry
seen the customer selection screen and now you are ready to begin

Start a 5250 emulation session.

2. In the User ID field, type your user ID.
3.
4. On the command line of the 5250 screen, invoke the Order Entry Application:

In the Password field, type your password.

CALL ORDENTR

The application starts and shows the first panel. This first screen prompts for a
customer number. You have a choice of keying in the customer number directly
or you can press command key F4 to display a list of existing customers.

© I session A - [24 % 80] N =10] x|

File Edit W¥ew Communication Actions Window Help
D 2% B =6 k% & 9 @l

Farts Order Entry

| 55" [Connected to remote server/host toras|pd101 on psprintl:pd101 7

[Accessing the online help.”|

application and

Exercise 1.2: Accessing the online help

Before you begin, you must complete [“Exercise 1.1: Starting the 5250 application.”|

Before you go ahead with the order entry process, try the help. This application
uses User Interface Manager (UIM) help. You will also convert these UIM help
panels with the WebFacing Tool. To understand the results of the UIM help
conversion, try the help in the 5250 environment and then later in the browser.

1.

Move the cursor to the Customer number field.

2 Development Studio Client: IBM WebFacing Tool



2. Press command key F1.
Panel group help displays for the customer number.

T oI

File Edit Yew Communication Actions ‘Window Help

|y %] B[] wd| tes[%| [cB| & @[

Farts Order Entry

I [connected to remate server/host toras|pd101 on psprinkl:pd101 A4

3. To see more help, move the cursor underneath the 1 in the help area and press
the Enter key.

Help for requesting a customer list displays.

T oI

File Edit Yew Communication Actions ‘Window Help

D 2% B =6 % & 9] @l

FParts Order Entry

Eottom

[ )" [Connected to remate server/host toras pd10L on psprintl:pd101 S

4. Press command key F12 to return to the help for the Customer number field.

5. To see help for the second choice, move the cursor underneath the 2 in the help
area and press the Enter key.

Now you see detailed help for specifying a valid customer number.

Chapter 1. Module 1. Reviewing the 5250 order entry application 3



T oI

File Edit Yew Communication Actions ‘Window Help

D 2% B =6 % & 9] @l

FParts Order Entry
1_||_-‘ choices, press Enter.

o)

i ECmnected ko remote serve"r.fhost toras | pd10l on psprintl:pd101 A

6. Press command key F12 to leave the help for the Customer number field.
The main help panel in the Select customer — Help area shows.

7. Press command key F2 to get to the extended help.
Here you see the extended help for the Customer number field.

T oI

File Edit Yew Communication Actions ‘Window Help

B DD 2% Em @6 L% s & el

art

| 55" [Connected to remote server/host toras|pd101 on psprintl:pdi01 b7

8. Press command key F12 to leave the extended help for the Customer number
field.

9. Press command key F12 again to leave the help for the Customer number field.

You have displayed help for the customer number field, for selecting a customer,
for specifying a valid customer number and extended help for the customer
number field and now you are ready to begin |[“Exercise 1.3: Selecting a customer.”]

Exercise 1.3: Selecting a customer

Before frou begin, you must complete [“Exercise 1.2: Accessing the online help” on|
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Now you have an understanding how the help panels in this application work and
look. Next you need to identify the customer related order. You have the choice of
specifying a valid customer number, or you can get a selection list of valid
customers. Use the selection list because it shows a record format that uses the
WINDOW DDS keyword and so you can see how the WebFacing Tool converts a
DDS window.

1. Press command key F4 to display the customer selection list.

A list of customers displays.
T oI

File Edit ‘Yiew Communication Actions ‘Window Help
B DB 2R @ w6 s & 2 @l

Parts Order Entry

'35 |Connected to remate serve'r.fhost toras pdl0l on psprintl:pd101

RN

2. In the Options field, type 1 to select a customer.
3. Press the Enter key to proceed.

This returns you to the initial panel now filled with detailed data for the
selected customer.

T oI

File Edit ‘Yiew Communication Actions ‘Window Help

_IE@J_I_!!I!I_J'&@ e8| 3| @lol

Parts Order Entry

[ 54" [Connected to remate server/host toras pd10L on psprintl:pd101

VA

You'll notice that an order number has been assigned as well. You are ready to
order some parts.

You have displayed the customer selection list and selected a customer from the
list and now you are ready to begin [“Exercise 1.4: Filling the order” on page 6/
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Exercise 1.4: Filling the order

Before you begin, you must complete [“Exercise 1.3: Selecting a customer” on page]

The process of selecting parts is similar to the way you selected a customer in the
previous exercise. You are able to key in the part number directly or select the part
from a selection list. Next you want to work with the parts selection list.

On the order entry panel:

1.

2.

Press command key F4 to see a list of available parts.

The Select Part panel opens.
T

File Edit ‘Yiew Communication Actions ‘Window Help
B DB 2R @ w6 s & 2 @l

Parts Order Entry

b
-+

:J I |Connected to remote serve'r.fhost toras pd10l on psprintl:pd101 i 4

In the Options field, type 1 next to a part that has lots of quantity left.
Back on the order screen, the part appears in the order; on the top line of the

parts list.

JT=TE

File Edit ‘Yiew Communication Actions ‘Window Help

B DD 2% Em) @6 % s & @l

Farts Order Entry

|z |Connected to remate server/host toras pd101 on psprintl:pd101 Vs

Next you order a certain quantity of this part.

3. Change the Qty field to a value, for example 2.

4. Press the Enter key to add the part and quantity ordered to the order.
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6.
7.

You have displayed the parts selection list, selected a part from the list and

specified the part quantity and now you are ready to begin

The detail order line for this part, with the quantity specified, is now part of

this order.
T

File Edit Wiew Communication Actions ‘Window Help
D 2% @ =6 % & 9] @l

Farts Order Entry

| 55" [connected to remote server/host toras|pd101 on psprintl:pd101 )

Add more parts until your order is complete.

Press command key F4 to see a list of available parts.
Select a part from the parts list and press Enter.
Specify the part quantity and press Enter.

[Completing the order.”

Exercise 1.5: Completing the order

Before you begin, you must complete [“Exercise 1.4: Filling the order” on page 6|

Now you are ready to accept the order. You use the Order Entry panel to complete
the order.

To complete the order:

1.

Press command key F6 to accept the order.

The order is added to the database and the next order can be filled. You return

to the starting screen of the application.

You have worked with all panels in this application:
* The start order entry panel

* Several help panels

¢ The customer list window

* The full order entry panel

* The parts list window

You can add more orders but if you understand how the user interface of this

application works, stop adding orders.

Press command key F3 to exit the application.

You are now ready to put a brand new user interface onto this application.

You have accepted the order and exited the application.

Chapter 1. Module 1. Reviewing the 5250 order entry application
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Module recap

You have completed [Chapter 1, “Module 1. Reviewing the 5250 order entryl

[application,” on page 1]You have learned how to:

Start a 5250 emulation session

Call the order entry application

View the customer selection screen

Display help for the customer number field

Display help for selecting a customer

Display help for specifying a valid customer number
Display extended help for the customer number field
Display the customer selection list

Select a customer from the list

Display the parts selection list

Select a part from the list

Specify the part quantity

Accept the order

Exit the application

Now that you know how the order entry application green screens, command keys
and help panels work and look, you can continue to [Chapter 2, “Module 2|

[Creating the WebFacing project,” on page 9.

8 Development Studio Client: IBM WebFacing Tool



Chapter 2. Module 2. Creating the WebFacing project

Before you can use the WebFacing Tool to reface your application you need to
create a WebFacing project in the workbench. The first step when starting with the
WebFacing Tool is to create a WebFacing project. You will identify the project
information, like the DDS source member names to be converted using the
WebFacing Tool, and they will be stored in a workspace on your workstation. You
will proceed through the process of identifying the DDS and UIM Panel Group
source members to be converted by the WebFacing Tool and specify some of the
runtime information you will need later when running the WebFacing application.

This module teaches you how to create a WebFacing project, something that you
need before you can create a Web user interface for the Order Entry Application.
You will then learn how to use this WebFacing project to facilitate the conversion
of your DDS source and to test the generated output.

In this module, you will:

e Start the product

* Set the default workspace

* Access unique views and tools targeted towards the WebFacing tasks
* Specify a name for your WebFacing Web Project

* Connect to an iSeries server

* Select DDS source members to convert

* Select UIM source members to convert

* Specify the CL command to invoke the application

* Specify the application signon values

¢ Select a Web style for your converted application

* Create the WebFacing Web Project without converting files

Exercises

The exercises within this module must be completed in order:

* [“Exercise 2.1: Starting the product” on page 10|

* |“Exercise 2.2: Opening the WebFacing perspective” on page 11|

+ |“Exercise 2.3: Starting the WebFacing Web Project wizard” on page 13|

* |“Exercise 2.4: Selecting display file members to convert” on page 14|

* [“Exercise 2.5: Specifying the CL command to launch the application” on page 19|

+ |“Exercise 2.6: Selecting a Web style” on page 21|

* |“Exercise 2.7: Completing the WebFacing project information” on page 22|

Time required

This module will take approximately 25 minutes to complete.

© Copyright IBM Corp. 2001, 2005 9



Exercise 2.1: Starting the product

Now go ahead and start the product.

To start the product:

1.

On the desktop task bar click Start > Programs > IBM Rational® > IBM
WebSphere Development Studio Client for iSeries V6.0 > WebSphere
Development Studio Client for iSeries.

'E IBM WebSphere Development Studio Client For iSeries w6.0  M|é& wWebSphere Development Studio Client For iSeries

A dialog appears asking you for the workspace location, unless you used the
product before and selected not to show this dialog again.

The workspace contains all the information about your projects. You can accept
the default or store the work related to this tutorial in a separate workspace.
You can always start with a new workspace later, if you don’t want to mix
these exercise WebFacing projects with your real work.

x

Select a workspace

1BM Rational Software Development Platform stores vour projects in a directory called a workspace.
Select the workspace directory to use for this session.

_:\Documents and Settings' I

sdp6.

Workspace: \ddministratord Ik;-ﬁr ationa

[ Use this as the default and do not ask again

Accept the default directory structure but change the name of the workspace
directory to the name WFLABxx where XX is a unique number.

Click OK.

After a few moments of loading, the workbench opens, and the initial window
of the product opens.

10 Development Studio Client: IBM WebFacing Tool



Rational Software Development Platform
X

Note: If you didn’t reset the workspace, or you are working with the advanced
version of the product, your environment will differ slightly from the
screen captures in this tutorial.

You have started the product and set the default workspace and now you are
ready to begin [‘Exercise 2.2: Opening the WebFacing perspective.”|

Exercise 2.2: Opening the WebFacing perspective

Before you begin, you must complete |“Exercise 2.1: Starting the product” on page|

The workbench shows the Remote System Explorer (RSE) perspective by default.
This is the perspective that you would use to work with iSeries objects. It allows
specifying connections to iSeries servers and provides for the programmer a
similar interface to iSeries objects as the Program Development Manager (PDM)
does in a green screen environment.

The WebFacing Tool provides it’s own perspective since it needs to give its users
access to unique views and tools targeted towards the WebFacing task. To create a
WebFacing project you first need to open the WebFacing perspective.

To open a WebFacing perspective:

Chapter 2. Module 2. Creating the WebFacing project 11



1. Click Window > Open Perspective > WebFacing from the workbench menu.

The workbench now shows the WebFacing perspective with the WebFacing
Projects view open in the left pane of the workbench.

@ webFacing - IBM Rational Software Development Platform B IQ Ex'
File Edt Mavigste Search Project Run Window Help

JEi-GI0 ] | 5% [3%-0-Q- £ | webradng
|| ™= | - TBRemote Syste...
 EiwebFacing Projects EE\‘MMJ =) ' (G50 N_EI:

An autline is not
available.

= Properties S:?\\Gélb'rﬂ WebFadi. . | =Ta)

IE% Sd W
_Property [ value |

Tﬁ:”s = [

AllFiles (%) x|

You are ready to start the WebFacing project wizard to create a WebFacing
project.
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You have accessed unique views and tools targeted towards the WebFacing tasks
through the WebFacing perspective and now you are ready to begin
[Starting the WebFacing Web Project wizard.”|

Exercise 2.3: Starting the WebFacing Web Project wizard

Before you begin, you must complete [“Exercise 2.2: Opening the WebFacing]
[perspective” on page 11|

A WebFacing project is a complete Web project with the directory structure and
files needed to conform to the Java 2 platform, Enterprise Edition (J2EE) standard
of a Web application. It also contains additional information unique to WebFacing,
like the source to be converted.

To start the WebFacing Web Project wizard:
1. In the WebFacing perspective, click File > New > WebFacing Web Project from
the workbench menu.

& webFacing - IBM Rational Software Development Platform
@ Edit Mavigate Search FProject Run Window Help

Close Chrl+F4
Close All ChrlShif44

[ Example...

Ctrl+5

B save s, % Other... Crl+N

This will start the WebFacing Web Project wizard.

2. In the WebFacing Web Project wizard you will be presented with the
WebFacing Web Project page.

WebFacing Web Project

& webFacing Web Project x|
-

Create a WebFacing ‘Web Project -"

You can create a new WebFacing Web project, or add WebFacing suppart to an existing Web project,

(' Create a new WebFacing praject

Name: flab

Project location: |C='I.Documents and SettingstAdministratori[BMirationalsdp6.0yw  Browse. .. I

" pidd WebFacing suppott to an existing Web project

| =
Show Advanced > I

3. In the Project name field, type the project name wflabxx where XX is a unique
number.

4. Click Next.
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The Select Display File Source Members to Convert page opens.

& webFacing Web Project x|

Select Display File Source Members To Convert

Select "Refresh DDS list” to refresh the library items displayed in the tree, Select members from T
the tree and add them to the table for conversion.

Project name: | wflabxx

Connection: | = New...l
Library: | *LIBL | File: | "I Member: l "l

Mermber types: [DSPF MIUDDS |

Click Refresh DDS list button , then select Files or members and add them to the table For conversion:

Refresh DO list I

Library | File [ Member

< Back Next > Finish | Cancel

You have specified a name for your WebFacing Web Project and now you are
ready to begin [“Exercise 2.4: Selecting display file members to convert.”]

Exercise 2.4: Selecting display file members to convert

Before you begin, you must complete [“Exercise 2.3: Starting the WebFacing Web|

[Project wizard” on page 13

On this second page of the WebFacing project wizard you need to specify the

name of the iSeries server that contains your display file DDS source, as well as
which members of the source file you want to convert. Specifically, the WebFacing

Tool needs to know these names:
e Server name

* Library name

* Source file name

¢ Member name

Note: You need to identify members for all record formats used in your
application. If you miss one and at runtime the record format gets
requested, your end user will get a Page not found error.

First since you are starting with a new workspace, you need to specify the iSeries

server name to specify where the Data Description Source (DDS) is located.
Connecting to an iSeries

To connect to an iSeries:
1. Click New beside the Connection list.
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@ webFacing Web Project x|

Select Display File Source Members To Convert —
Select "Refresh DDS list” to refresh the library items displayed in the tree, Select members from s
the tree and add them to the table For conversion. t' /

Project name: vald:b:x

Connection: | ;’
e =] Fies Member

Member types: |DSPF MNUDDS =l

The Name personal profile page opens.

Name personal profile
Uniguely name user profile | |

Welcome to Remote Systems, Connections can be sharable by the team or private to
you. Enter a profile name to uniquely identify you from your team members. You wil
decide for each new connection whether it is owned by the team profile or your
prafile,

Prafile; I msteckh7tp

< Back I Next > I Finish | Cancel I

Accept the default profile name as this is your own private connection.
Click Next.
The Remote iSeries System Connection page opens.

Chapter 2. Module 2. Creating the WebFacing project
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x|

Remote iSeries System Connection

Define connection information | l

Parent profile: |msteckh?tp ;I

Connection namme: I 54003

Host name: | 54003 —ﬂ

Descriptions |

[V Werify host name

<Back | mext> || Frish |  Cancel |

4. In the Host name field, type the name of the host system, for example s400a.

Note: This is your iSeries server name; don’t use the one shown unless your
system is named s400a.

The connection name will be filled automatically with the same value.

5. Leave the Verify host name check box selected to verify that the host name or
IP address exists.

6. Click Finish.
The connection is created and can be re-used by all tools in the workbench.

The connection wizard also checks whether the iSeries host can be reached
and if this test is successfully completed, you return to the Select Display File
Source Members to Convert page.

7. Check that your iSeries server is selected in the Connection list.

& webFacing Web Project ] x|

Select Display File Source Members To Convert m—
Select "Refresh DDS list” bo refresh the library items displayed in the tree, Select members from ol 1
the tree and add them to the table for conversion. f /

Project name: | wlabux

Curnsctinn: _:] New..'l
Lrbrary- v| File: ] '] Member: -

Member types: [DSPF MNUDDS d|

8. Make sure that *LIBL is selected in the Library list.
9. Click Refresh DDS list.
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& webFacing Web Project g x|

Select Display File Source Members To Convert —
Select "Refresh DDS list” bo refresh the library items displayed in the tree, Select members from i g
the tree and add them to the table For conversion, | :‘ /

Project name: IwFlabo:x

Connection: |s400a | |Naw...|
Library: | *LIBL | File: | "I Member: I "I

Mermber types: [DSPF MIUDDS |

Click Refresh DDS list button , then select Files or members and add them to the table For conversion:

A User ID and password dialog opens.

& Enter Password x|

System type: iSeries
Host name:  TORASO7M

User ID: IWLthx
Password; | Forerr
¥ Save user ID

¥ Save password

| oK I Cancel I

10. In the User ID field, type your user ID. Use the same user ID that you used
when running the Order Entry application in |Chapter 1, “Module 1)
[Reviewing the 5250 order entry application,” on page 1.

11. In the Password field, type your password.

12. Select the Save user ID check box.

13. Select the Save password check box.

14. Click OK.

A connection to the iSeries server gets established. The library list of your
iSeries job is displayed under the Refresh DDS list button on the Select
Display File Source Members to Convert page.

Refresh DDS list

- Bk QHLPSYS
- Bk QUSRSYS
- Bk, WFLABYXY
BB, WSSLABKK

E
i
&
i
]
&

Selecting DDS source members

To select DDS members to convert:
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1. Select the WFLABXX library from the list.
2. Click the plus sign (+) beside the WFLABXX library to expand it.

{® webFacing Web Project x|

Select Display File Source Members To Convert =
~f —

3 members added for QDDSSRC 7

Project name: | wflabxx

Connection: [s400a =] new...|
Library: v | File: ¥ Member: -

Member types: |DSPF MNUDDS 'l

Click Refresh DDS lisk button |, then select files or members and add them ko the table For conversion:

Refresh DDS lisk |

TORASO7M *LIBL *ALL *ALL DSPF b

[+, QUSRSYS
= QGPL

= B WFLABNY
§20 FaY
- ®-l oaLsre

[ oppssRC
@[ oopssrep < { o
-l PN SRC

<pack  [Cnext>Y]  rosh | cancel

3. Select the QDDSSRC source file from the expanded list.

4. Expand QDDSSRC and select all members from the list.

5. Click _>> | push button in the middle of the page to copy the selected
members over to the list of members to be converted at the right.
Tip: To move all members in a source file you can select the source file icon

itself and click the __>> | push button. This will add all members in a source
file to the list of members to be converted.

The WebFacing Tool now knows which DDS members to convert for this
project. The conversion hasn’t been done but the information is stored for
future use.

Next you convert UIM source members.
Selecting UIM source members

To select UIM source members to convert:
1. Click Next to proceed to the next page of the wizard.
The Select UIM Source Members to Convert page opens.
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{® webFacing Web Project : x|

Select UIM Source Members To Convert
1 members added for QPMLSRC

Project name: | wflabxx

Connection: |<4005

Library: |"1_I& :] File: :] fMember: | "l

Click Refresh UIM list button , then select files or members and add them to the table for conversion:

Refresh UIM list |

TORASO7M *LIBL *ALL *ALL PNLGR. Libr. File Member
H-E QUSRSYS QFNLSRC ORDENTRPNL
-2 QGPL

= Bl WFLABXY

@ H _‘IQ
- @ qesee

< Back [@] Firiish | Cancel I

Now you have to identify the panel group source containing the help
information for the Order Entry application.

Click Refresh UIM list push button.
Expand library WFLABXX.
Select the QPNLSRC source file from the expanded list of library WFLABXX.

Al

Click __>> | push button in the middle of the page to copy all members over
to the list of members to be converted at the right.

There is actually only one panel group member ORDENTRPNL in this source
file.

6. Click Next to proceed to the next page of the wizard.
The Specify CL Commands page opens.

You have connected to an iSeries server, selected DDS source members and UIM
source members to convert and now you are ready to begin |”Exercise 2.5:|
[Specifying the CL command to launch the application.”]

Exercise 2.5: Specifying the CL command to launch the application

Before you begin, you must complete [“Exercise 2.4: Selecting display file members|
[to convert” on page 14

You will now provide the information that will allow the WebFacing Web Project
wizard to create the initial index.jsp page to start the Order Entry application. Do
you remember what you typed on the command line to start the Order Entry
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application in the 5250 emulation session during the first exercise in kfhapter 1,|
[“Module 1. Reviewing the 5250 order entry application,” on page 1P In case you
forgot; it was: CALL ORDENTR

Why should you remember? The WebFacing run time needs to know the
invocation command for your application in order to send this invocation
command to the iSeries server to start your application from the browser. The page
in the WebFacing Web Project wizard will allow you to specify the necessary
information CL command and Sign on information.

& webFacing Web Project B x|

Specify CL Commands ___

Enter the CL commands that are used in your application, the command labels you want to use, and the r e il
signon preference For the generated hypertext links, I f /

Project name: | wilaboex

WebFacing generates hypertext links that vou can use to launch vour application from the web. In order to do this, it
needs ko know the text that will be shawn for each link and the CL command that each link will invoke, ©n this page
wou can define multiple links, in case several CL commands are used to launch your application.

If your program requires parameters, you can enter them as variables in the CL command. For example: to invoke
program MYPGM with a part number parameter, you would enter CALL MYPGM PARM(Rpart) as the CL command. The
variable "&part" will be replaced when vou click on the invocation link, For details, refer to the generated index,html
file. The invocation name is used ko uniguely identify each hyperlink in the index.htmi file.

CLcommand: | CALL ORDENTR

Command label: |0rder Entry Application

Invocation name | vl

~——

" Prompt for signon Madify |

pecify 05/400 signon values
User 1D | WFLABXX

Password I*""“"‘“"‘"‘""" Confirm password |""""“"""""""‘c
L
L Command I Command Label ! Invaocation name [ User 1D
CALL ORDENTR Order Entry Applica... TNV *PROMPT
< Back ( Next = ] Firish Cancel

To specify the CL commands:
1. In the CL command field, type CALL ORDENTR
2. In the Command Label field, type Order Entry Application.

Note: If you don’t type anything into the Command Label field, the CL
command input will be copied into this field.

3. Leave the default value INV1 in the Invocation name field.
4. Click the Specify 0S/400® signon values radio button.

This will automatically apply the user ID and password you used when you
connected to your iSeries server in the previous dialog for selecting source
members for invocation of this application. You will use this setup here for
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testing purposes to make it easier for you to start the Order Entry application
without specifying the authentication information. Don’t worry about security

in your production environment, this can be easily changed later and you will
see how to do this later in this tutorial.

5. Click Add on the right side of the page.

Note: Make sure the text and command you typed into the fields are actually
shown in the CL Command table at the bottom of the page.

6. Click Next at the bottom of the wizard page.
The Choose a Web Style page opens.

You have specified a CL command to invoke the application and the application
signon values and now you are ready to begin [“Exercise 2.6: Selecting a Web)|
h

Exercise 2.6: Selecting a Web style

Before you begin, you must complete [“Exercise 2.5: Specifying the CL command to|
[launch the application” on page 19,

Next you select a Web style for your converted screens.

To select a Web style:

& webFacing Web Project x|
Choose a Web Style _
Select a "Look and Feel" style to use for the project, e

" Enable for Web Site Designer
(' Select classic WebFacing style

Select a predefined or previously customized style:

avenue

corporatel
e o —
onra

sagel ::‘

texctbutbons s ion

ey

< Back l N> ] Firiish | Cancel

1. Select the gradient style from the list of available styles.

Chapter 2. Module 2. Creating the WebFacing project 21



2. Click Next.
The Completing WebFacing Project page opens.

You have selected a Web style for your converted application and now you are
ready to begin [“Exercise 2.7: Completing the WebFacing project information.”|

Exercise 2.7: Completing the WebFacing project information

Before you begin, you must complete [“Exercise 2.6: Selecting a Web style” on page|

On this page you have choice of creating the project and converting the source in
one step or only creating the WebFacing project.

You will just create the WebFacing project. You don’t need to convert the source
now. Conversion is part of the next module.

@& webFacing Web Project

Complete WebFacing Project

You have indicated the specifications for your new WebFacing project. To continue, click Finish.

R

You are about to create a WebFacing project.
Do you also want to convett the selected display files?

" ¥es, Iwant to create the project and proceed with conversion n{}{.

@Nu. 1 onky want to create the project now.

< Back [ Mext = r@] Cancel |

To complete the WebFacing project information:
1. Select the No. I only want to create the project now radio button.
2. Click Finish.

The WebFacing project is created. The workbench opens in the WebFacing
perspective with your new WebFacing project in the WebFacing Projects view.
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'y

= jWebFacing Projects X, N{ERLEIG i Servers[ =

Notice that the WebFacing project icon indicates which J2EE level will be used
for the project.

If you expand the wflabxx project you'll notice several files and folders have
been added to this WebFacing project:

¢ The information for display file source members to be converted

* The information for panel group source members to be converted

¢ The CL Command that will be used to start the Order Entry application
* The style to be used for the converted screens.

When you expand the folders and files under your WebFacing project you can
see the information that is captured for this project.

'y

= \WebFacing Projects X SE{ENLELGTS i Servers [ =

= L= CL Commands
'“E Crder Entry Application

<5400 >'WFLAERQDDSSRC(ORDENTD)
254008 =WFLABXX/QDDSSRC(SLTCLSTD)
L £sd00a>WFLABLY/QDDSSRC(SLTPARTD)
=7 UIM Help

4 (2 <s400a>WFLABXY/QPNLSRC(ORDENTRPNL)
E-L§ Style

-C§ gradient

- [ index.jsp %

& logon.isp
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3. Click each folder or file. Click the plus + sign beside each file or folder.

Tip: If you later need to add source members to the WebFacing project,
right-click the DDS or UIM help icon and click Add on the pop-up menu. This
will launch the WebFacing Web Project wizard and display the correct dialog.

Mavigator i Servers l ]

=113 wilabxox
=L CL Commands
., Order Entry Application
& (2 DDS
¥ (), <s400a>WFLABX/QDDSSRC(ORDENTD)
i “ <S4|I|a'}W'FL.QB)C(IIIQDDSSRC(SLTCUSm)
i (. €sd400a>WFLABXY/QDDESRC{SLTPARTD)

w-Cp <54 New » LLSRC(ORDENTRPNL)
=-L% e
= —S LE:I;er open
S O e Wit b
-] index,jgs e R
oo
Delete
Style 4
Convert
Wiew Log
Propetties

You have created the WebFacing Web Project without converting files.

Module recap

You have completed [Chapter 2, “Module 2. Creating the WebFacing project,” on|
You have learned how to:

e Start the product

* Set the default workspace

* Access unique views and tools targeted towards the WebFacing tasks
* Specify a name for your WebFacing Web Project

* Connect to an iSeries server

* Select DDS source members to convert

* Select UIM source members to convert

* Specify the CL command to invoke the application

* Specify the application signon values

* Select a Web style for your converted application

* Create the WebFacing Web Project without converting files

You have created a WebFacing project and in this project you specified which
display file source and panel group source to convert and which iSeries server
these source members are located on. The WebFacing Tool will use this information
during the conversion process. You have to specify in this next module whether
you want to convert all source members belonging to this project or selected ones
only. A word regarding security, in case you are wondering, why you don’t have to
logon to the iSeries server during conversion. Your user ID and password have
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been stored during the WebFacing project setup and will be re-used here. Continue
to [Chapter 3, “Module 3. Converting selected source members,” on page 27
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Chapter 3. Module 3. Converting selected source members

This module teaches you how the WebFacing conversion creates the JSP files for
the browser User Interface description, XML files for record format layouts, and
several other files needed for the Web application. You will learn how to select the
convert option, start the conversion and work with the conversion logs to check
the results of the WebFacing conversion.

In this module, you will:

* Select members to convert

* Convert members

¢ Check reference keywords for errors

* Check the DSPF conversion log for errors

¢ Check the UIM conversion log for errors
Exercises

The exercises within this module must be completed in order:

* |“Exercise 3.1: Selecting the project and source members”|

* |“Exercise 3.2: Starting the WebFacing conversion” on page 29|

* [“Exercise 3.3: Checking the conversion logs” on page 31|

Time required

This module will take approximately 10 minutes to complete.

Exercise 3.1: Selecting the project and source members

You will use the product to do the WebFacing conversion, if it is not up and
running already, start it now. If it is still up and running on your workstation you
are ready to go ahead.

If the WebFacing perspective with your project is not visible, you need to open the
WebFacing perspective.

Opening the WebFacing perspective

To open the WebFacing perspective:

1. Check the taskbar of the workbench for the WebFacing perspective icon and if
you find it, click on the icon to switch to the WebFacing perspective that is
already open but not active at the moment.

Tip: Avoid having too many instances of the same perspective open. It will
improve performance of the workbench if you restrict yourself to one instance
of a specific perspective being open. We have seen situations with 50
perspectives being open at the same time; this has caused severe performance
impacts, so be careful.

Here you see the icons on the taskbar of the workbench. The Remote System
Explorer perspective is active. The workbench window title bar shows this.
Four perspectives are open in the workbench.
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@& Remote System Explorer - IBM Rational Software Development Platform -0 x|
File Edit Mavigate Search Project Run ‘Window Help

[l [%-0-Q- | % [ | ERemote syste...
|+ N Pweb  ElJava
Bremote Systems 2 Taarnl =05 @ welcome 12 L 75 WebFacing J
® 8| AEERlE Rational Somware Le
#- .4 Mew Connection
B Local
- B s400a

@ The WebFacing perspective

@ The Remote System Explorer perspective
E The Java perspective

. E The Web perspective
2. To switch to the WebFacing perspective. Select its icon T from the taskbar.

Tip: The icon E on top of the taskbar allows you to open a new perspective.
Next you start the conversion in the WebFacing perspective.

Selecting members to convert

To select members to convert:

1. Select the WebFacing project you have been working on in the previous
module, wflabxx.

2. Expand this project by clicking the plus sign (+) beside its icon in the
WebFacing Projects view.

T ‘WebFacing Projects X
E---E“ wlabxx
Elti CL Commands
= Q Order Entry Application
=y DDS
" (2 <s400a>WRLABKKIQDDSSRC(ORDENTD)
- 42y <s400a>WFLABXX/QDDSSRC(SLTCUSTD)
B (2 <s400a>WFLABLYQDDSSRC(SLTPARTD)
= Co IS
] EI C@ <s400a>WFLABRXIQPNLSRC(ORDENTRPN
=8 Style
- @8 gradient
- [& index.jsp
..... & logon.jsp

< | Bl

You should see a DDS folder in the expanded view.

If you don’t see a DDS folder, you might be in the Navigator view and not in
the WebFacing Projects view.

3. Check that the view title bar is not WebFacing projects.
4. Locate the WebFacing Projects tab at the top of the list view, and click it.
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1~ WebFacing Prajects. X IEHEL =08
=V wlabsxx
= L; CL Commands
Q COrder Entry Application
= (& DDs
] {Fi, <s400a>WFLABKXIQDDSSRC(ORDENTD)
+ <s400a>WFLABXXIQDDSSRC{SLTCUSTD)
] 254003 >WFLABLIQDDSSRC(SLTPARTD)
= Co IS
(%) <s400a>WFLABXXIQPNLSRC{ORDENTRPN
=3 S‘_j Style
-8 gradient
~[& index.jsp
~[& logon.isp

< | B

Now the WebFacing Projects view should be active and you should be able to
find the DDS folder.

I WebFacing Projects X Navigator| =&

=V wilabxoc
= (g CL Commands

EREN
i (2 <s5400a>WFLABKY/QDDSSRC(ORDENTD)
({2 <s400a>WRLABY/QDDSSRC(SLTCUSTD)
& =:s4£l[!a)WFLAB%QDDSSRC(SLTPARTD}

& (5 <s400a>WFLABKXQPNLSRC{ORDENTRPR,
= 8 Style
-8 gradient
~[& index.jsp
& logon.isp

«| | »

5. Expand the DDS folder, so that you can see all three of the members that you
selected in the previous module.

Next you convert these members.

You have selected members to convert and now you are ready to begin
[3.2: Starting the WebFacing conversion.”|

Exercise 3.2: Starting the WebFacing conversion

Before you begin, you must complete |“Exercise 3.1: Selecting the project and source]
[members” on page 27

From here you can select individual members to convert or a collection of
members. When you later in this tutorial change only one source member you will
select a single member to be converted. Since you want to convert all members in
the project, you can actually work with the WebFacing project icon to convert DDS
and UIM panel group members.

1. Right-click the wflabxx WebFacing project.
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]
E=
L= CL  New 4
I"E
=-Gool OEET
T_|'-“ Open wWith » NTD)
# 'F Add 5TD)
L E : ui Delete.., RTD)
[} ?
A Style 3
oRey tirer
i+ -Cs ag
-~ Inc
5] log Run »
Debug »
Profile 3
Deplay
Team »
Compare With »
Restore from Local History...
Migrate »
Properties
4 | ]

2. Click Convert on the pop-up menu.

The conversion process starts. You will see a progress dialog, indicating what
members are being converted.

X
@ Converting 1 - 3.

AENEEEENNENENEENENEREEER
Parsing: <s400a >WFLABXX/QDDSSRC{ORDENTD)

Wait until the progress dialog disappears, indicating the WebFacing conversion
has finished.

You have converted members and now you are ready to beginm
[Checking the conversion logs” on page 31
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Exercise 3.3: Checking the conversion logs

Before you begin, you must complete |“Exercise 3.2: Starting the WebFacing]

fconversion” on page 29

Notice the conversion log in the right pane of the workbench.

@ webFacing - wflabxx Log - 1BM Rational Software Development P

Fil= Edit Mavigate Search Project Run Window Help

[ 7]~ % |8-0-Q-

5 | [ webFacing
EBremate Syste..,

DSPF Conversion Log

Display Files

Records

This section lists all display Files that
have been converted.,

v (5 WFLABXX/QDDSSRC(ORDENTD)
v (5 WRLABKXIQDDSSRC(SLTCUSTD)
v (5 WFLABXXQDDSSRC(SLTPARTD)

Errors

This section lists all the records ir
converted display file,

This section lists all errors For the selected object.
© all messages

O Compile messages only

O Conversion messages only

Message ID | Line | Severity | Message Text

To check the conversion log;:

1.

2.
3.
4

Click the Overview tab.
Click the Reference Keywords tab.
Click the DSPF Conversion Log tab.

Click the UIM Help Conversion Log tab.

As you click each tab you will see more details about each log.

You have now converted the DDS display file and panel group source.
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The DDS source and panel group source is now available in a form a browser
understands. The first important step to move your application to the Web is done.
Notice, the conversion itself was pretty easy, because you already did the hard part
when you created the WebFacing project. Now that the project exists the
WebFacing Tool has all the information readily available and even having to
re-convert later because of changes in the original source is not a big problem.

You have checked the DSPF and UIM conversion logs for errors.

Module recap

You have completed [Chapter 3, “Module 3. Converting selected source members,”|
You have learned how to:

e Select members to convert

* Convert members

¢ Check reference keywords for errors

* Check the DSPF conversion log for errors
* Check the UIM conversion log for errors

You have used the WebFacing Tool to convert the user interface of the Order Entry
application and you now want to see the conversion results. The WebFacing Tool
created a complete Web application that can be run in an Application Server. The
WebSphere Application Server test environment and the Web project in the
workbench are completely integrated and without publishing (copying) any of the
files in the Web project they are known to the WebSphere Application Server test
environment.

The index jsp file that has been created by the WebFacing conversion routine is
part of this Web project. It will be used as the default page for this Web
application. When the application is up and running you will go through the same
scenarios as in [Chapter 1, “Module 1. Reviewing the 5250 order entry application,”|
fon page 1] when you went through the green screen panels of the Order Entry
application but now you are using the new WebFacing user interface.

Next you will run your application with its new user interface. Continue to
[Chapter 4, “Module 4. Running the WebFacing application,” on page 33
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Chapter 4. Module 4. Running the WebFacing application

You normally would now have to copy all the files of your Web project to a
WebSphere Application Server and then run your application there. However, there
is a WebSphere Application Server included with the product and it is called the
WebSphere Test Environment (WTE). Using WTE makes the process of locally
testing your WebFacing application easier than testing on a remote WebSphere
Application Server.

In your real application development environment, you would test thoroughly in
the test environment; then export the WebFacing project files to a remote
WebSphere Application Server for final testing, before moving the Web-enabled
application to your production WebSphere Application Server environment.
Chapter 12, “Module 12. (Optional) Exporting to iSeries WebSphere Application|
Server Express 6,” on page 127/ shows you the steps required to deploy to a remote
WebSphere Application Server environment. Until you are sure your WebFacing
application is ready for public use, you can use the test environment on your
workstation, which simplifies the testing of Web applications.

This module teaches you how to test your WebFacing application in the
WebSphere Test Environment. You will learn how to specify in the WebFacing
perspective that you want to run your project in the WebSphere Test Environment.
From the initial Web page, you will learn how to select the link created by the
WebFacing Tool to invoke the WebFacing Order Entry application.

In this module, you will:

* Set the WebSphere Test Environment to test the application locally
* Launch the WebFacing application

¢ Prompt for a customer

* Select a customer from a list of customers

¢ Prompt for a part

* Select a part from a list of parts

* Enter a quantity for a part

* Display help for the customer selection list
Exercises

The exercises within this module must be completed in order:

* |[“Exercise 4.1: Showing the index.jsp page” on page 34|

* |“Exercise 4.2: Testing the WebFacing application” on page 36|

» [“Exercise 4.3: Testing the help support” on page 39|

Time required

This module will take approximately 15 minutes to complete.
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Exercise 4.1: Showing the index.jsp page
To show the index.jsp page:

1. Right-click index jsp in the WebFacing Projects folder.

N
= 5[ # oroent
Overy
=& pbs General
This sect
about tk
T P
o Total Of
Open With » Total UI
Conyvert nnuer
Yiew og 3 r
. [
3
Pofie b QRun..
Deploy 1 | Muasusca g

2. Click Run > Run on server on the pop-up menu.

A Server Selection dialog opens.

@ Server Selection !

Define a New Server

Choose the type of server to create.

How do you want to select the server?
" Chonse an ExIsting seryer
(& Manually define a server
Specify the host where you want to publish

Host name: | localhost
Select the server type:

Le

WebSphere vS Server Attach
- webSphere 5.0 Server
-85 webSphere vS.1 Server
g5 WebSphere v6.0 Server

(= Other

L]

.

View By: I\fenl:lnr i |

Description: Runs JZEE projects on the WebSphere 6.0 Server,

efet setver as project default {do not prompt)

< Eack mext> [ Finish |

Cancel
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You can avoid having this dialog open every time you select run on server.
. Leave the Manually define a server radio button selected.

. Click the WebSphere v6.0 Server server. This is the WebSphere Test
Environment for Version 6.0.

. Select the Set server as project default (do not prompt) check box.

. Click Finish.

The WebSphere Application Server test environment starts. A Server Selection
information message dialog opens. Click Run in Background. After a few
moments the browser opens in the upper right view area of the workbench. Be
patient; it takes time for the application server to start on your workstation.

The minimum memory requirement for running the WebSphere Application
Server test environment is 768 MB according to the IBM announcement letter
for the product Version 6. You can run this WebFacing project successfully on
systems with 256 MB. It will take more time for the application server to start if
you are working on a workstation that has less than the required memory. The
system speed will also have an impact on the application server start up time.
Eventually you will see the index.jsp page that has been generated by the IBM
WebFacing Tool opening in the workbench’s built-in browser.

Here you see the browser inside the workbench with the index.jsp page
displayed.

Lo 9 [ wlabxx Log | g
I:‘ttp:,l'll'locdhnst:gl]J'wflabxx;‘index.jsp :] = | o - .-{jr"v | .
Select program to start 2l

= Order Entry Application

Done
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Tip: To enlarge the browser window to the size of the workbench window,
double-click the browser title bar. To get it back to its original size in the upper
right hand workbench view area, double-click the enlarged browser window
title bar.

You have a choice of running WebSphere Application Server Version 5, Version
5.1 or Version 6.0 in the workbench test environment. In this tutorial you will
be using WebSphere Application Server Version 6.0 in the Test Environment
and J2EE level 1.4.

You have set the WebSphere Test Environment to test the application locally and
now you are ready to begin [“Exercise 4.2: Testing the WebFacing application.”|

Exercise 4.2: Testing the WebFacing application

Before iou begin, you must complete [“Exercise 4.1: Showing the index.jsp page”|

To run the Web application:
1. In your browser pane, click the Launch link.

After a few moments the first application page opens in the browser.

er Entry Apphcation
Parts Order Entry
Type choices, press Enter.

mEnter 2=Change
mEyit - o - 1
= Prompt ustomer number. .. ... [ rder number . ..,
mF12
EmHELP
4' I ”_P_l

If you find the response time slow, keep in mind that the first time the JSP file
is requested, it has to be compiled into a servlet the first time. If you run the
application a second time, you will see improved performance since the
servlet already exists. This is normal application server behavior.

Now you want you to go through the same steps as in [Chapter 1, “Module 1]
[Reviewing the 5250 order entry application,” on page 1[to review the results
of the WebFacing conversion. This will give you a sense of how the default
conversion will change your original application. You will then have a chance
to improve the conversion results.

2. Click the Prompt button, or press command key F4 to open the selection list
window.

36 Development Studio Client: IBM WebFacing Tool



|
Parts Order Entry

Type choices, press Enter,

Customer number . ... ... To select customer
Type choices, press Enter,
1=Select
Opt Customer
[__ Oakley, Annie O
[_f Barber, Elizabeth A
w F2IT, GeOrge
‘B eiss, Claus
" Coulthard, Phil
Gungabeesoon, Satish
Fair, Jim ]
Coulter, Simon S
Masn, Maha
Llames, Joe L

| [

Fkeyl2=Cancel

Select a customer from the list (this is your converted subfile).

ke

Parts Order Entry

Type choices, press Enter,

E 2=Change
B Customer number . . . .... o004 Order number .......: 4011
= Customer name , .. ..., : weiss, Claus
- address . ..ot 8200 Warden Ave
i ol S Markham On  L6G 1C7
Opt Part Description Qty

—

-
Press the Enter key.

Click the Prompt button, or press command key F4 to display the parts
selection list.
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Type choices, press Enter ‘_’

2=Change
Select Part
Customer number .. .....
Customer name . ... ...: Type choices, press Enter.
BEAFESE: i ovv v aneieis 1=Select
Gl geain gises Opt Part Description Qty

0oooo0l1 WEBSPHERE REDBOOK

000002 Radio_Controlled_Plane

000002 Change_Machine

000004 Baseball_Tickets S

000005 Twelve_Num_Two_Pencils

000006 Ower_Under_Shotgun

000007 Feel_Good_Witamins

000008 Cross_Country_Ski_Set J:‘
»

Kl I
6. Select a part.

Opt Part Description

G | = | o

7. Press the Enter key.
The Parts Order Entry window opens.

Taer cation il

Parts Order Entry

Type choices, press Enter,

2=Change
Customer number ....... 0004 Order number .. .....:
customername . ..., ... Weiss, Claus
Address ...t 8200 Warden Ave
CiBY oA Markham Oon  L6G 1C7
Opt Part Description Qty
000005 Twelve Num_Two_Pencils | 2

4 il

8. Enter a quantity.
9. Press the Enter key.
10. Continue ordering one or two more parts.

11. Press command key F6 to accept the order.

The application works the same way as before in a 5250 environment; but the
application now has a browser user interface.

You have launched the WebFacing application, prompted for a customer, selected a
customer from the list of customers, prompted for a part, selected a part from a list
of parts and entered a quantity for a part and now you are ready to begin
[“Exercise 4.3: Testing the help support” on page 39|
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Exercise 4.3: Testing the help support

Before you begin, you must complete |“Exercise 4.2: Testing the WebFacing]
lapplication” on page 36

To test the help:
1. Press the F1 key.
Another browser window opens with the help information.

-loix]
[httpiifiocahost: ] B+ | %5 ~ CREEN |
Extended help
Select Customer - Help
Use this panel to specify a customer to work
with. Choose one of the following options:
o 1. Select
« 2 Enter nurmber
=
Dane

2. Now try the links:

* 1. Select

* 2. Enter number

* Extended help

Your UIM based help panels are all available in the WebFacing application.
3. Close the help browser window and press F3 to end the application.

You have displayed the help for the customer selection list.

Module recap

You have completed [Chapter 4, “Module 4. Running the WebFacing application,”|
You have learned how to:

* Set the WebSphere Test Environment to test the application locally
* Launch the WebFacing application

* Prompt for a customer

* Select a customer from a list of customers

* Prompt for a part

* Select a part from a list of parts

* Enter a quantity for a part

* Display help for the customer selection list

Next you want to improve the user interface generated by the WebFacing Tool. You
want to improve the customer selection subfile. The Web user interface for
selecting a record from this subfile does not work like a Web application. You have
to key 1 into the options column to select a record; this is how the green screen
application works. You want a Web user interface where you can click on a link to
select a customer.
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You will be guided through the Web Setting capabilities in CODE Designer to
make the necessary modifications. You will change the second column in the
customer selection subfile, which contains the customer name, from a simple text
output field to a link. When you click on this new customer name link, the correct
information your program expects is sent. You might ask what is the correct
information? What is your program expecting? It is expecting a 1 in the subfile
options field for the selected customer record. The program will receive the same
information after you change the user interface.

The WebFacing conversion will add logic to the user interface, so that the options
field is filled with a 1 and the Enter key event is invoked when the link is pressed.
You enhance the user interface and don’t have to change the application, this
sounds pretty impressive doesn’t it. Continue to [Chapter 5, “Module 5. Changing]
[the user interface,” on page 41
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Chapter 5. Module 5. Changing the user interface

To enhance the results of the WebFacing Tool, you will use the feature Web
Settings in the CODE Designer tool. CODE Designer is the GUI-based screen
design tool for 5250 panels. It allows you to change certain aspects of the user
interface related to the WebFacing conversion process. CODE Designer stores the
Web Setting information as comment lines in the DDS source. When you convert
the application using the IBM WebFacing Tool, these DDS source comment lines
are picked up and applied to the new user interface.

This module teaches you how to change the user interface of your WebFacing
application with CODE Designer. In the WebFacing perspective you will learn how
to select a DDS source member to work with; start CODE Designer to open this
DDS member; work with Web Settings in CODE Designer to change the Web look,
and then reconvert the DDS member.

In this module, you will:
* Locate a DDS source member
* Open a DDS source member with CODE Designer
— Create a hyperlink action for the option field
— Hide the option field
— Hide the option heading for the option field
— Hide the select instruction
— Change the appearance of text
— Close CODE Designer
* Open a DDS source member with the LPEX Editor
— Create a hyperlink action for the option field
- Hide the option field
— Hide the option heading for the option field
— Add a new WebFacing class and change a headings location
— Hide the select instruction
— Change the appearance of text
— Close the LPEX Editor
* Reconvert the DDS source members
* Launch the reconverted WebFacing application
* Prompt for a customer and part

* Verify the changes in the customer selection window and the part selection
window

In order to accomplish these learning objects, there are several steps that are
involved, including:

* |“Exercise 5.1: Opening DDS display file source in CODE Designer” on page 42|

* |“Exercise 5.2: Applying Web Settings in CODE Designer” on page 42|

* |“Exercise 5.3: Opening DDS display file source in the LPEX Editor” on page 49|
* |“Exercise 5.4: Applying Web Settings in the LPEX Editor” on page 49|
» |“Exercise 5.5: Testing the changed application” on page 60
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The exercises within each module must be completed in order. Start with
[5.1: Opening DDS display file source in CODE Designer”| when you are ready to
begin.

Length of time:
This module will take approximately 30 minutes to complete.

Exercise 5.1: Opening DDS display file source in CODE Designer

Since you will use the WebFacing perspective to invoke CODE Designer you start
this exercise using the product in the WebFacing perspective.

Starting the product and opening the Web perspective (optional)

Skip this section if the product is already started and the Web perspective is
already open.

To start the product and open the Web perspective:

1. Start the product and open the WebFacing perspective, if it is not up and
running already.

2. In the WebFacing perspective, make sure that you are in the WebFacing Projects
view and not the Navigator view.

3. Expand your project in the WebFacing Projects view by clicking on the plus
sign (+) beside the WebFacing project icon if not already.

Opening CODE Designer
1. Locate the DDS display file source named STLCUSTD.

2. Right-click SLTCUSTD and click Open with > CODE Designer on the pop-up
menu.

You have located the DDS source member and opened it with CODE Designer and

now you are ready to begin |“Exercise 5.2: Applying Web Settings in CODEF]

Exercise 5.2: Applying Web Settings in CODE Designer

Before you begin, you must complete [“Exercise 5.1: Opening DDS display file]
[source in CODE Designer.”|

Now work with the Notebook underneath the Design page.
Creating a hyperlink for the option field

To create an hyperlink for the option field:
1. Click the SCREENT tab.
2. Locate the Web Settings tab.
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Details  SCREEN1 ISaumeI Listing |

[ EcusTsr ~l[E[«]=]cosTomer -] [0 B2 3

|%llgnore all indicators

Selected DDS  Web Settings Jcomments | Ercor st |

<3 CUSTOMER
[&] Visibility
[¢] Location
\¢#] Program defined HTML
~o[ef) User defined HTML
1t] Appearance and Text
Lol Insert HTML
0] Create graphic
: ";_'d‘_ Create hyperlink
o[tf] Dynamic key label

3. Place the cursor on line 8, column 7.
4. Click the Web Settings tab.
The Web Settings page in the CODE Designer window opens.

Selected DDS  Web Settings | Comments | Enor list |

== CUSTOMER
L [0 visibilty
Lol Location
6] Program defined HTML
“o[0] User defined HTML
[¢¥] Appearance and Text
~g] Insert HTML
&) Create araphic
| Create hypeilink
[¢] Dyniamic key label

5. On the Web Settings page, locate the list that shows the different Web Settings

available for the Customer field.
6. If not all Web Settings show, scroll down to the bottom of the list.
7. Click Create hyperlink in the Web Settings list.
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| SelectedDDS  Web Settngs | Comments | Enorist|

= CUSTOMER & hyperink
'{’E bl vertide browser's hyperlink appeatance with DDS appearance
[0 Location Specily static URL
) Frogram defired H' Croose afiid [
0] User defined HTML
0] Appearance and T LIAL [
(0] Inset HTML
o) Cigalaaach Tagel] —
" JavaScpl hyperirk

" JavaScript function cal |

| i—

8. Select the Create hyperlink check box to the right of the list.

9. Clear the Override browser’s hyperlink appearance with DDS appearance
check box.

10. Click the Action hyperlink radio button.

11. Leave the Position cursor to field check box selected.

12. From the list under the Position cursor to field select the &{OPT?} value.

13. In the Enter data list type 1.
This indicates that you want a 1 to be entered in the Options field when the
hyperlink is clicked.

14. Select the Submit check box.

15. Leave the Function key radio button selected.

16. Select ENTER from the Function key list.

Just to recap, you specified the following, when the application gets converted
with the WebFacing Tool; the customer name cells in the subfile will be
generated so they appear as links in the browser window. At run time, when
the link is clicked, a 1 will be placed in the Option field. Also, a submit
request will be initiated to generate the equivalent of pressing the Enter key
and the cursor will be positioned in the Option field for the selected row.
You have accomplished the basic task, but the user interface now has an
Option column that doesn’t belong there since it is useless with the new link.
Also the instructions on the page on how to select a customer are wrong. You
want you to fix this with Web Settings as well before you test this new
feature.

Hiding the option field

On the Design page, you now need to select the Opt field to indicate that you
want to work with it:
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Selected DDSE Eeb Sel!iné’] Comments ] Error list [
EF=Y: '
Lo

To hide the option heading:

1. Click the Opt column on the first record in the subfile to select it.
2. On the Web Settings page select Visibility from the list.
3. Select the Hide field radio button.

Now this column in the subfile will be hidden.

Hiding the option heading for the option field

You need to hide the heading for the Opt field as well. The heading is not in the
subfile record; it is located in the subfile control record. Therefore you need to give
focus to a different record format in the Design page. What does this mean? It
looks like one record format but there are three record formats in this view.

Lets look at some of the CODE Designer features. Normally in the iSeries green
screen world, your screens are made up out of multiple record formats that at
runtime get assembled by the RPG or COBOL program to present the real screen
your end user sees.

To make it easier for you at design time to get a feel how the record formats you
create would look like at runtime, CODE Designer has added the notion of a
group. You can assemble several record formats in a group. This feature gives you
the capability of mimicking what happens at runtime with your record formats. So
a group resembles the runtime grouping of record formats for you at development
time. In the sample you are working with, there are already assembled three record
formats in group SCREEN1. The record formats are:

e CUSTSFL
* CUSTCTL
e SLTCUST

To get a list of record formats belonging to a group you can expand the list of
record formats.

&

-
iy

r e
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Only one record format in a group is active at a time. The record format name is
listed in the top field of the record list. Also in the Design page all parts in the
active record format are shown highlighted but the inactive record format content
is half-intensity. You see this effect very clearly above. Until now you have been
working with the subfile record format CUSTSFL only, but now you need to clean
up the subfile control record format CUSTCTL, so you need to make it the active
record format or another way to describe this, give it focus.

To hide the option heading Opt Customer:

1. To shift focus to another record format, at the top of the Design page, click the
arrow.

. Details SCREEN1 |Suurc:el Ijstingl

- CUSTSFL |

II_Z’ |gnare all indicators

You will notice that the top area of the Design page is now highlighted, and the
bottom one has only half-intensity. As mentioned before the highlighted area is
the one you can work with.

Next you clean up the subfile control record format.

EETETS 5= Ol R
. lgnore all indicators J

Selected DD Ceb Settings} Comments | Error list |

=1~ 'Opt Customer'
[3] Wisibility [~ Change style class |

[¢] Location
-[a] F'rogram defined HTr

[#] Usprde

[ Appealance and Te:-

]

I Ovenide constant text |

From [4
@ide characters T @
0

On the Design page, select the OPT Customer constant.

On the Web Settings page, select Appearance and Text from the list.
Select the Hide characters check box.

Leave 1 in the From field.

Type 3 in the To field.

This hides the heading Opt. Now you need to remove the instructions on the
panel that guide the user to put a 1 into the Opt field to select a specific
customer.

ook wN

Hiding the select instruction
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You don’t have to give focus to a different record format since this constant is also

located on the CUSTCTL subfile control record format.

To hide the select instruction:
1. Select the constant 1=Select in the Design page.

| :.I

|

‘ Selected DD5 {web Seltinéai Comments | Error st |
B A ekt |

|

g viiity

2. On the Web Settings page select Visibility from the list.
3. Click the Hide field radio button.

Changing the instruction (Type choice press Enter)

Now you need to add new instructions for the WebFacing page, so the end user
knows to click the link to select a customer.

Note: Note you can’t just change the 5250 constant because you might still use this

screen in a 5250 environment, you have to use Web Settings to apply this
change to the Web user interface only.

To change the instruction text:

1. Select the instruction constant (Type choices press Enter) on the Design page.

Selected DDS  'Web Settings | Comments | Error fist |

@ Visibliy [" Change style class |
] Locat e —
- : P?ot:;;:]dellned HTIM@VaﬁdE constant le:d( Click on link to select 3

= Type ¢ Enter! H

I Hide characters

2. On the Web Settings page, select Appearance and Text from the list.
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3.

Select the Override constant text check box, and type the new text Click on
Tink to select in the field to the right of the check box.

Now all Web Settings are in place and you can go ahead and save the DDS
source and reconvert this DDS member.

Closing CODE Designer and reconverting the DDS source member

To close CODE Designer and re-convert the DDS member:

1.

Click the X button at the top right corner of CODE Designer.

m <R15400A>WFLABD2,/QDDSSRC(SLTCUSTD) - CODE Desig|

File Edit View Insert Selected Took Help

FEMBEE] E%) =[=() [@fe]

[ @l <R15400A>WFLA | Details SCREENT | Sowce | Listinal

Click Yes to save, when asked to do so.
You return to the WebFacing perspective in the workbench.
Select your project wflabxx in the WebFacing Projects view.

Expand the project by clicking on the plus sign (+) in front of its icon, if you
can’t see the DDS folder as part of the project.

Expand the DDS folder, if it is not expanded already, to show all members in
this folder.

='m
=T wilabxx
(& L Commands
=2 pos
i) (el <5400a>WFLABRKIQDDSSRC(ORDENTD)
R <5400a>WFLA B T
4y <s400a>WFLA e
% UM Help Open
-y Style OpenWith ¥
index.jsp S
~[&] logon.jsp Add
Delete
Style 3
Wiew Log !
Properties

Select the member SLTCUSTD that you just changed.
Right-click SLTCUSTD member icon.
Click Convert on the pop-up menu.

Only this member will be converted. A conversion report opens after the
conversion is finished. Now you test the new user interface.

You return to the WebFacing perspective in the workbench.

You have created a hyperlink action for the option field, hidden the option field,
the option heading and the select instruction, changed the appearance of text,
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closed CODE Designer and reconverted the DDS source member and now you are
ready to begin [“Exercise 5.3: Opening DDS display file source in the LPEX Editor.”|

Exercise 5.3: Opening DDS display file source in the LPEX Editor

Before you begin, you must complete [“Exercise 5.2: Applying Web Settings in|
[CODE Designer” on page 42

Next, you open the DDS member in the Remote Systems LPEX Editor, locate the
DDS source you want to change and then use the Web Settings tab to make the
changes.

|' Thumbnails | Styles | Colors | Links | S Riweh Settings X,
To edit the Web settings for a DSPF DDS member, open the DSPF DOS member in the LPEX Editor,

1. Locate the DDS display file source named SLTPARTD.

2. Right-click SLTPARTD and click Open with > Remote Systems LPEX Editor on
the pop-up menu.

You have located the DDS source member and opened it with LPEX Editor and
now you are ready to begin [“Exercise 5.4: Applying Web Settings in the LPEX]

Exercise 5.4: Applying Web Settings in the LPEX Editor

Before you begin, you must complete [“Exercise 5.3: Opening DDS display file|
[source in the LPEX Editor.”|

Creating a hyperlink for the Part field

First, let’s add a hyperlink to the IID field. You use the Outline view to locate the
IID field which represents the Part number.

To create an hyperlink for the IID field:
1. In the Outline view, expand SLTPARTD and then PARTSFL and locate the IID
field.
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Notice the cursor is positioned on the IID field in the DDS source.
2. Click the Web Settings tab.

3. On the Web Settings page, locate the list that shows the different Web Settings
available for the IID field.

4. Click Hyperlink in the Web Settings list.
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10.

11.
12.
13.

| Colors 2 4ieb Settings X SlMes]Servers!Comole | Tasks | Thu'nbnails[ =&
E-fe 1D ble hyperlink
i E Appearance “Fo
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e E Dynarmic key .
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@‘Suhmt Function key: w -
" Call JavaScript:
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Select the Enable hyperlink check box to the right of the list.
Select the Use browser settings check box.

Click the Perform actions radio button.
Select the Position cursor to field check box.

From the list under the Position cursor to field select the
&{PARTCTL.OPT.REF} value.

Select the Set field value to check box and change the value to 1 in the field
to the right of the check box.

This indicates that you want a 1 to be entered in the Options field when the
hyperlink is clicked.

Select the More actions check box.
Click the Submit function key radio button.
Select ENTER from the Function key list.

Just to recap, you specified the following, when the application gets converted
with the WebFacing Tool; the part number cells in the subfile will be
generated so they appear as links in the browser window. At run time, when
the link is clicked, a 1 will be placed in the Option field. Also, a submit
request will be initiated to generate the equivalent of pressing the Enter key
and the cursor will be positioned in the Option field for the selected row.

You have accomplished the basic task, but the user interface now has an
Option column that doesn’t belong there since it is useless with the new link.
Also the instructions on the page on how to select a customer are wrong. You
want you to fix this with Web Settings as well before you test this new
feature.

Hiding the option field

Chapter 5. Module 5. Changing the user interface 51



In the Outline view you now need to select the Opt field to indicate that you want
to work with it.

.Thun'bnais |Stybs | Colars |L|nks| Sarvers| Console §:=3T

== opT ~Visibility
8 Appearance |~ yigble

18]

@l N
@ " Hide characters o I_

Tios I

To hide the option heading:
1. Click the Opt field in the Outline view to select it.
2. On the Web Settings page select Appearance from the list.
3. Click the Hidden radio button.
Now this column in the subfile will be hidden.

Hiding the option heading for the option field

You need to hide the heading for the Opt field as well. The heading is not in the
subfile record; it is located in the subfile control record. Therefore you need to give
focus to a different record format. What does this mean? It looks like one record
format but there are three record formats in the Outline view.

The record formats are:
* PARTSFL
* PARTCTL
e SLTPARTD

Until now you have been working with the subfile record format PARTSFL only,
but now you need to clean up the subfile control record format PARTCTL, so you
need to make it the active record format or another way to describe this, give it
focus.

To hide the option heading Opt Customer:
1. To shift focus to another record format, click PARTCTL in the Outline view.
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Next you clean up the subfile control record format.
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Qty constant.

Select the Hide characters check box.
Leave 1 in the From field.

Type 3 in the To field.

This hides the heading Opt.

o ok~ w

In the Outline view, expand PARTCTL and then select the Opt Part Description

On the Web Settings page, select Appearance from the list.

Changing the Opt Part Description Qty constant to line up with data

If you ran the finished application you would see that the headings Part,
Description, and Qty do not align with their corresponding data.
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Select Part

Click on link to select

Part Description Oty
000001 WEBSPHERE REDBOOK 78 &
000002 Radio_Controlled_Plane 1,398/
000003 Change_Machine 14
000004 Baseball Tickets 397
000005 Twelve_Murm_Two_Pencils 765
000006 Ower Under_Shotgun 65
000007 Feel_Good_Vitamins 345
000008 Cross_Country_Ski_Set 21
000009 Rubber_Baby_Bugagy_Wheel 345
000010 ITSO REDBOOK SG24-2152 294:]

To fix this alignment problem, you will edit the Cascading Style Sheet (.css file)
that WebFacing uses to add a new WebFacing class. You will learn more about this
style sheet in the next module. You will also change the location of the constant to
further improve the alignment of these headings.

To locate the Cascading Style Sheet file:
1. Locate the apparea.css file in the WebFacing project.

|»

L CL Commands
&=Lz} DDS

<5400a>WFLABXX/QDDSSRC(ORI
' <5400a>WFLABKKIQDDSSRC(SLT
(L <s4D0a>WRLABKYIQDDSSRC(SLT

-9 UIMHelp

é Style
aradient
(= apparea

|8 CurrentSegment.gif
B |£| Downérrow, gif
o [8] Leftarrow.gif
- [#] rightarrow.gif
- [®] Uparrow.gif

- 8| apparea.css
= @ button_dn.gif
-] button_up.gif
-~ [#] cseparator.gif
- [¥] next.gf

|8 prev.gif

- @ seament, aif
[+ = chrome

- index.jsp =
« | r?ﬁ

It is located in the following directory hierarchy:
wflabxx\Style\gradient\apparea\

2. Double-click the apparea.css file icon to open an editor for this file.
Next you add a new WebFacing font style class.
The editor dialog will open and show the style source.

3. Scroll to the bottom of the source file.
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4. Position the cursor at the end of the last line of the .popupErrorMsgClose
class, after the ending curly (}) bracket.

5. Press the Enter key to insert a line.
6. Enter the following new class:

H
.plpupEer:HsgClDiE {
background-color : red ;
color : white ;
cursor : hand ;
X
.Uf_field_co {
font-family : Courier:
font-size : 9pt:

Note: Don’t forget the semicolon to delimit the line and the ending curly (})
bracket.

7. Save the change by clicking the Save icon in the workbench.

@& webFacing - appare|

File Edit Style Source

Now you need to update the Web Settings for the Opt Part Description Qty
constant to use the new class.

8. In the Outline view, select the Opt Part Description Qty constant.
9. On the Web Settings page, select Appearance from the list.
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Dynamic ke
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)| Image
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Select the Override style class check box, and change the class name to

wf_default wf_field_co in the field to the right of the check box.
On the Web Settings page select Location from the list.
Change the value in the Column field to 5.

Thumbnails | Styles ] Colots | Links | Setvers | Console "f,?« Weh
=1-Az 'Opt Part De
-|@r Appearar
|!| Dynamic b
@] HTML ove
Hypetlink
|| 1mage
@ Location

Sioe [l |

Settings X

Position
¥ change position Row: |5
column; [5] =7

Now you need to remove the instructions on the panel that guide the user to put a
1 into the Opt field to select a specific part.

Hiding the select instruction

You don’t have to give focus to a different record format since this constant is also

located on the PARTCTL subfile control record format.

To hide the select instruction:
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1. Select the constant 1=Select in the Outline view.

FE whlabxx Log I (@ Web Browser m 5% Outline 52 =8)
Line 49 Coluwmn 45 Replace & B DUMMY |
+TDpEL inpogﬁumtions B e e ey = E? SLTPART
003300 1') & =[5 WINDOW(*DFT 19
003400 A9701074 REL-V4RZMO 5769-PwW1 || = 1 = = WINDOW(*DF]
003500 SFLCTL (PARTSFL) 92 ovERLAY
003600 SFLSIZ(11) Ay’
003700 SFLPAG(10) - * COLOR(BLU,
003800 WINDOW (SLTPART) ! &1 Position 18,1
003900 SFLDSP - E3 PARTSFL
004000 SFLDSPCTL | ®IS TEXT(Select Custol
004100 SFLEND ( *HORE) &2 OPT 1,0
004200 OVERLAY - I=! EDTCDE(Z) vaL
004300 1 20'Select Part' &1 Position 7,2
004400 DSPATR (HI) -3l 11D
004500 3 1'Type choices, press Ent -2
004600 COLOR (ELUJ ¢ -lg Reference *LIE
4 3I1=5e lect! © il Position 7,5
-3l INAME
COLOR (BLT) -3kl STQTY
004900 6 1'Opt Part Description - @l IPRICE
004501 2 E5 parTCTL
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005100 DSPATR (HI) [ A5 'Select Part'
005200 = # g;‘a ‘Type choices, pres
[#-5 "1=5elect’
i] —[ —’l_ & #5, 'Opt Part  Descript_|
-
| Al EH
Thumbnals | Styles | Colors | Links | Servers | Console | (3:teb Settings 52 = 1)
=45 'L=Select’ ~Visibity 4
% APPESraNce | yisible
@ Dynamic key
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Image
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2. On the Web Settings page select Appearance from the list.

3. Click the Hidden radio button.

Changing the instruction (Type choice press Enter)

Now you need to add new instructions for the WebFacing page, so the end user

knows to click the link to select a part.

Note: Note you can’t just change the 5250 constant because you might still use this
screen in a 5250 environment, you have to use Web Settings to apply this

change to the Web user interface only.

To change the instruction text:

1. Select the instruction constant (Type choices press Enter) in the Outline view.
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2. On the Web Settings page, select Appearance from the list.

3. Select the Override constant text check box, and type the new text Click on
Tink to select in the field to the right of the check box.

Now all Web Settings are in place and you can go ahead and save the DDS
source and reconvert this DDS member.

Closing LPEX Editor and reconverting the DDS source member

To close LPEX Editor and re-convert the DDS member:
1. Click the X button at the top right corner of CODE Designer.

[Ewﬁebxx Log IQW&I: Browser
Line 485 Column 45 Replace
setesrsBisnetesrn Tt

J//#SLTPARTD

003300 1a

003400 SD 19971030 201743 49701074

2. Click Yes to save, when asked to do so.
You return to the WebFacing perspective in the workbench.
3. Select your project wflabxx in the WebFacing Projects view.

4. Expand the project by clicking on the plus sign (+) in front of its icon, if you
can’t see the DDS folder as part of the project.

Chapter 5. Module 5. Changing the user interface 59



5. Expand the DDS folder, if it is not expanded already, to show all members in
this folder.

i= WebFacing Projects X
=113 wilabxsx
L= CL Commands
Bl DDS

Mavigator | ==

<s400aWFLABXR/QDDSSRC(ORDENTD)
«s400a>WFLABXR/QDDSSRC(SLTCUSTD)

[CRE WELA SLTPARTD)
[#-% UIMHelp New 4
-8 Style

index.jsp Open

5] logon.isp Cpen With  »
Add
Delete
Style 3
Yiew Log g
Properties

6. Select the member SLTPARTD that you just changed.
7. Right-click SLTPARTD member icon.
8. Click Convert on the pop-up menu.

Only this member will be converted. A conversion report opens after the
conversion is finished. Now you test the new user interface.

You return to the WebFacing perspective in the workbench.

You have created a hyperlink action for the option field, hidden the option field,
the option heading and the select instruction, changed the appearance of text,
closed LPEX Designer and reconverted the DDS source member and now you are
ready to begin [“Exercise 5.5: Testing the changed application.”|

Exercise 5.5: Testing the changed application

Before you begin, you must complete [“Exercise 5.2: Applying Web Settings in|
[CODE Designer” on page 42

Let’s see the new user interface in your application.

To test the changed application:
1. Right-click index.jsp in the WebFacing Projects view.
2. Click Run > Run on Server on the pop-up menu.
3. Go to the browser pane and click the Launch link.
You will see the first screen of your application. Nothing has changed there.
4. Click the Prompt push button, or press command key F4.
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=="01der Lty Application =

Parts Order Entry

Type choices, press Enter,
2=Change

Customer number . .. .. .. To select customer %
Click on link to select

Customer
Oakley, Annie O
Barber, Elizabeth &
Earr, George
Weiss, Claus
Coulthard, Phil
Gungabeesoon, Satish
Eair, Jim ]

il

The customer selection window appears and the customer fields are shown as
links. Also notice the changed text and the non-visible option column.

Note: If the customer selection window is still showing the old option
selections, most likely the browser has cached the page and you need to
close the browser window, and restart the application. This will open a
new instance of the browser without cached content.

5. Select a customer from the list by clicking on the link.
6. Click the Prompt push button, or press command key F4 for the Part field.

Parts Order Entry
ress Enter,
er. ... .. Select Part
R Click on link to select
Fart Description Qty
cription 000001 WEESPHERE REDEOOK =l
000002 Radio_Controlled_Flane 1,398
000003 Change_Machine 14
000004 Baseball_Tickets 2397
000005 Twelve_Mum_Two_Pencils 765
000006 Over_Under_Shotgun 65
000007 Feel_Good_Vitamins 345
000008 Cross_Country_Ski_Set 31
000009 Rubber_Baby_Buggy_Wheel 345
000010 ITSO REDBOOK SG24-2152 294;]

&

The part selection window appears and the part fields are shown as links. Also
notice the changed text and the non-visible option column.

Note: If the part selection window is still showing the old option selections,
most likely the browser has cached the page and you need to close the
browser window, and restart the application. This will open a new
instance of the browser without cached content.
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7. Go through the same steps as in |[Chapter 1, “Module 1. Reviewing the 5250
forder entry application,” on page 1[to test the changed application.

You have launched a reconverted WebFacing application, prompted for a customer,
verified the changes in the customer selection window, prompted for a part and
verified the changes in the part selection window.

Module recap

You have completed [Chapter 5, “Module 5. Changing the user interface,” on page|
You have learned how to:

¢ Locate a DDS source member

* Open a DDS source member with CODE Designer
— Create a hyperlink action for the option field
— Hide the option field
— Hide the option heading for the option field
— Hide the select instruction
— Change the appearance of text
— Close CODE Designer
* Open a DDS source member with the LPEX Editor
— Create a hyperlink action for the option field
— Hide the option field
— Hide the option heading for the option field
— Add a new WebFacing class and change a headings location
— Hide the select instruction
— Change the appearance of text
— Close the LPEX Editor
* Reconvert the DDS source members
* Launch the reconverted WebFacing application
* Prompt for a customer and part

* Verify the changes in the customer selection window and the part selection
window

When you tested the changed application, you found that you didn’t like the way
the WebFacing Tool mapped some of the display attributes to colors and text styles
available in the browser. You wanted to change the default WebFacing style rules
that determine how certain 5250 parts are displayed in a browser to give the Web
user interface a better look. Now you will make these changes. Continue to
[Chapter 6, “Module 6. Changing the style of the Web user interface,” on page 63
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Chapter 6. Module 6. Changing the style of the Web user
interface

This module teaches you how to change the user interface of your WebFacing
application by using the WebFacing style properties dialog. The style changes are
applied on a project level; so all pages in a project will be displayed with these
changes applied. In this module you will change the text color and font for all
highlighted fields. You will also locate the style file where these changes have been
stored.

In this module, you will:

e Start the Style Properties dialog

* Change the DDS Field Display Attributes
* Locate the cascading style sheet file
 Edit the cascading style sheet file

* Check the new styles

Exercises

The exercises within each module must be completed in order:
* |“Exercise 6.1: Changing the rules for highlighted fields”]

* [“Exercise 6.2: Changing styles directly” on page 66|

+ |“Exercise 6.3: Testing the changed application” on page 70|

Time required

This module will take approximately 5 minutes to complete.

Exercise 6.1: Changing the rules for highlighted fields

During this exercise you will use the Style Properties dialog in the IBM WebFacing
Tool to tailor your Web user interface. You will change the rules for highlighted
fields in the 5250 panels so they appear more visible in the Web user interface. The
style for highlighted fields will be altered so at runtime the text font will be
different and a larger font size will be applied.

To change the rules for highlighted fields:

1. Start the workbench of the product and open the WebFacing perspective, if it
is not up and running already:.
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Team >
Compare 'With +
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2. Right-click the wflabxx project.
3. Click Properties on the pop-up menu.
The WebFacing project properties dialog opens.

@i Properties for wilabxx I

:_=:j - Conversion Project

Command Key Recognition ) .
Command Key Button Labe "¥EDFacing project settings:

- Edit Code Options General | authentication |
MNLIDDS Options

¥ Handle as if DDS files are compiled with DFRWRT(*YES) option

“Order Entry Application [ Uise insert mode For keyboard text entry
DDS Object Mappings

¥ Cache Job Date (DATE(*0B))
¥ Conwert text to uppercase for Katakana (W) keyboard shift

4 | E

XML Record Metadata Host name: | TORASO7M Host port: | 40% Change. .. |

UIM Object Mappings ™ Include command key name in the key label {2.g. Incude "F3=" in "F3=Return" label}
:I Stﬁ:\u'eb ¥ Enable Web page compression
D03 Ei ¥ Field exit key: [&m |
ODS Field Display Attribute
Window I Override the maximum record wait time (\WAITRCD) specified for DDS files
|~ Subfile
Command Keys Number of seconds (*MOMAX, 1 - 32767): I - I
Error detail level(1-3): [3_3

[ ]

Cancel

4. Under Style in the left pane of the Properties for wflabxx, click DDS Field

Display Attributes.

In the right pane of the Properties for wflabxx, the DDS Field Display
Attributes pane opens.
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. x
E1- Conversion DDS Field Display Attributes
| Command Key Recogrition
Command Key Butten Labe  vo,, can customize how each DDS display attribube appears on the Web page by changing the
Edit Code Options corresponding item.
MNLDDS Options
| XML Record Metadata Fixed raw height: l =l
£1-Run Time =
T B Project Alignment Font-size: | 9 [ Sample
Order Entry Application
DDS Object Meppings | Defauk fisdfont: [ Verdana, Reguler, 9 5l sample
- UIM Object Mappings
| Bliking: [verdans, 1ale, o _[ | oseaa(eL)
- Style
DD Field Color Column separators: [cseparator.af
DDS Field Display Attribut
~ Windaw Repsat: lRepneat horizontaly l |
o postoni| 7]
Command Keys
Hghmtensky: | Verdena, Bold 9 U| DSPATR(HI)
Underine: [verdens, Reguir Underine, s .| | DspaTRL)
Protected: | o)
j|—]
[k | coea |
5. Click the .. push button to the right of the High intensity field.
The Font dialog opens.
N 2x|
Fant: Font style: Size:
Comic Sans MS [Bad [ ok |
T Centaur ~| [Regular
() Courier Mew
H CourierThai
€} Estrangelo Edessa ﬂ
~Effects - [ Sample
I Strikeout
Fllors | AaBbYyZz
Calor:
I- Black Vl Scripk:
IWestem :J
6. Under the Font list, select Comic Sans MS.
7. Under the Font style list, select Bold.
8. Under Size, select 16.
Note: Don’t try to change the color in this dialog, the color setting doesn’t
work, later in this module you will see how to change the color.
This changes the font size and appearance for parts that have the high
intensity attribute active.
9. Click OK on the Font dialog.
10. On the Properties page, click OK.
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Checking the new style
Let’s check the new style in your application.

To check the new style:

1. Right-click index.jsp in the WebFacing Projects view.

2. Click Run > Run on Server on the pop-up menu.

3. Go to the browser pane and click the Order Entry link.

You will see the first screen of your application.

Note: See the different font and font size of some of the text; these are the
highlighted areas of your 5250 screen.

4. Prompt for the customer.

The customer selection screen has highlighted text and this text should show in
font Comic Sans MS and size 16.

er En pplication
Parts Order Entry

mEnter Type ch
®Cancel 2=Ch
= HELP To select customer
Custom{  ciick an link to select AN

Customer
Oakley, Annie O
Barber, Elizabeth A
Farr, George
Weiss, Claus

Coulthard, Phil
Gungabeesoon, Satish

Fair, Jim 1

Coulter, SimonsS
Masri, Maha

Llames, Joe L Rd

FkeylZ2=Cancel

Note: If the text is still showing the old fonts, most likely the browser has
cached the page and you need to close the browser window, and restart
the application. This will bring up a new instance of the browser without
cached content.

5. The Font dialog has a bug that makes it impossible to change the Font colors
directly. Next you see how to directly change WebFacing style classes.

Attributes and checked the new style and now you are ready to begin

You have started the Style Properties dialog, changed the DDS Field Displa
[6.2: Changing styles directly.”|

Exercise 6.2: Changing styles directly

Before you begin, you must complete [“Exercise 6.1: Changing the rules for]
[highlighted fields” on page 63

Instead of working with properties in the WebFacing project you can also change
the styles being applied directly in the Cascading Style Sheet (.css) file that
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WebFacing uses. In this exercise you see where this file is located in the WebFacing
Project structure and how to find your way around in this file.

To locate the Cascading Style Sheet file:
1. Click the Navigator tab to switch to the Navigator view.

[B WebFacing Projects Ef“»! Na*lgabor! ==
=T wilabxoc

L_i CL Commands
=+ pos
(2 <s400a>WFLABXX/QDDSSRC(ORDENTD)

¥ 1 <5400a>WFLAEXQDDSSRC(SLTCUSTD)
{2 <s400a>WFLABXX/QDDSSRC(SLTPARTD)
L% UIM Help
-8 Style

- & index.jsp

@ |DQDI'I.]SD

2. Locate the apparea.css file in the WebFacing project.

WebFacing Projects S =t 1 Te.g =

~ JavaSource
‘ = WebContent
[3 & META-TNF
= theme
p webfacing
&= ClientSeript
[#-(= images

R =

It is located in the following directory hierarchy:
wflabxx\WebContent\webfacing\styles\apparea\

3. Double-click the apparea.css file icon in the Navigator view, to open an editor
for this file.

Next you change the WebFacing highlighted style class.
The editor dialog will open and show the style source.
4. Scroll down the source file until you reach the .wf-hi class.
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PAaCKIJround-coLo0r  BeccoII ) :J
H

wf bl |

font-style @ italic:

}

.WE ¢33 {
hackground-image : url (cseparator.gif):
hackground-repeat : repeat-x;

bhackground-position : 0% 120%;
3

.WwE hi

{
font-style:normal;
border-left-color:black; -J

font-family:Comic Sans MI;
horder-top-color:black:
font-weight:bold:;
fonc-size:lépc:
}
SPAN.wf ul {
text-decoration : underline:;
}
.mf_pr {
bhorder-width: 0 0 2 0O;
color: HE66666;

H
.mf_td_pt{

wizibhilicy: hidden
3 -
il _l_I

You'll notice your changes from the previous exercise are applied here. The
WebFacing Tool has created style sheet classes for the different 5250 parts and
attribute combinations and stored them here. Each of the lines starting with a
dot is containing a style class name. The statements inside the curly brackets
after the style class name describe the attributes of the class itself. For this
WebFacing .css file, the name of the classes are self describing, for example
.wf_hi defines how a part that has the highlighted attribute active gets
displayed in the browser, wf_cs describes the column separator, etc. You can go
in and change the display characteristics for any of the 5250 attributes.

Next you change the color attribute of the highlighted class.

5. Position the cursor at the end of the last line of the wf_hi class, before the
ending curly (}) bracket.

6. Press the Enter key to insert a line.
7. Enter the color attribute you want to use, for example: color: red;
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background-repeat @ repeat-x; .‘..‘.J
background-position : 0% 120%;

H

.wf_hi

{

font-style:normal;

border-left-color:black;

font-family:Comic Sans MS;
border-top-color:black:

font-weight:bold;

2 = bpt:
color: red; _J
H

SPAN.uwf_ul {
text-decoration : underline;
H
.T-Jf_p‘-: 1{
border-width: 0 0 2 0O:
color: HEE6666;
H
.wf nd pr{

wvisibilicy: hidden s
ki |
k

Note: Don’t forget the semicolon to delimit the line.
8. Save the change by clicking the Save icon in the workbench.

@& webFacing - appare|

File Edit Style Source

105 - Hile |

There is a feature available in the Style sheet editor that allows you to look at

the changes you have made to a class directly in the editor without actually
invoking the page and showing in a browser.

9. Look at the left beside the Style sheet editor.

Selected Style
Style of .wf_hi

Standard HTML Elements

Text n Body Text m Body
Text n Body Text i Body

Heading 1 Heading 1

Headil[g 2 Heading 2

Heading 3 Heading 3

To see the changed user interface, run the application again.

You have located the cascading style sheet file and edited it and now you are
ready to begin [“Exercise 6.3: Testing the changed application” on page 70|
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Exercise 6.3: Testing the changed application

Before iou begin, you must complete [“Exercise 6.2: Changing styles directly” on|

To test the changed WebFacing application:

1. Click the X in the Window bar of any editors or views still open at the right
upper hand side of the workbench to close them all.

Now let’s check the new style attribute in your application.

2. Right-click index.jsp in the WebFacing Projects view or Navigator view in the
WebFacing perspective.

3. Click Run > Run on Server on the pop-up menu.

4. Go to the browser pane and click the Order Entry link.

You will see the first screen of your application. Notice the different color of the
text in the highlighted areas of your Web page. Prompt for the customer. The
customer selection screen will show the same changed attributes; remember
style changes are applied to all pages as shown.

| »

er En pplication
arts Order Entry

Type choices, press Enter,

2=Change

Customer number .R P
CTo select customer.

Ll '..L on T L SEIELL

Dakley, Annie O
Barber Elizabeth &

Earr, George

Weiss, Claus
Coulthard, Phil
Gungabeesoon, Satish
Eair, Jim ]

Coulter, Simon §
Masri, Maha
Llames, Joe L

4 ol

Note: If the text is still showing the old colors, most likely the browser has
cached the page and you need to close the browser window, and restart
the application. This will open a new instance of the browser without
cached content.

You might not have noticed it before, but there is still a command key
description at the bottom of the Customer Selection list window.

You might have guessed it; you will fix this in the next module.

Module recap

You have completed [Chapter 6, “Module 6. Changing the style of the Web user]
finterface,” on page 63]You have learned how to:

* Start the Style Properties dialog
* Change the DDS Field Display Attributes
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* Locate the cascading style sheet file
* Edit the cascading style sheet file
e Check the new styles

In the sample Order Entry application, the Customer Selection list window doesn’t
follow the CUA® rules for command key descriptions. The WebFacing Tool will by
default not recognize these command key descriptions and will not delete them.
The Order Entry main screen has a command key enabled that has no description
associated with it. The WebFacing Tool by default can’t handle this situation and
puts a default string in the push button label representing this command key. Next
you learn how to enable the WebFacing Tool to deal with these common green
screen environments. Continue to [Chapter 7, “Module 7. Adding command key]|
[rules and labels,” on page 73|
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Chapter 7. Module 7. Adding command key rules and labels

Most of the command key descriptions placed at the bottom of the original panels
in the sample Order Entry Application have been removed from the WebFacing
user interface. The removal happens automatically if the command key
descriptions follow the Common User interface Access (CUA) rules (for example,
F3=Exit). If they don’t follow these rules you can supply the WebFacing Tool with
the command key description rules you use in your user interface, and the
WebFacing Tool will apply these rules to recognize your specific command key
descriptions. One of the record formats in the sample application contains a
command key description that doesn’t follow the CUA rules.

This module teaches you how to use the WebFacing conversion properties dialogs
to add your own command key description rule. Also in your user interface you
might have enabled command keys without describing them in the user interface
because they are only used for specific functions and your end user knows how
they work. For example command key 3 for ending an application or command
key 12 for canceling a task are well known to be enabled for these tasks. So your
user interface might not list them explicitly at the bottom of the panel. The
problem with this kind of user interface design, the WebFacing Tool doesn’t have a
string it can put in the label of the push buttons on the Web page. It will just put
for example CF12 for an active command key 12 in the push button label.
However there is an alterative, the WebFacing Tool allows you to specify labels for
these common command keys so it can label the command key push buttons
correctly. You just have to tell the WebFacing Tool in its conversion properties what
the label is.

In this module, you will:

* Start the Properties dialog

* Select Command Key Recognition Patterns
¢ Add a new command key rule

* Reconvert the DDS members

¢ Test the applied new rule

¢ Change the text for the F12 command key
* Reconvert the DDS members

¢ Test the new command key label
Exercises

The exercises within this module must be completed in order:

* |“Exercise 7.1: Adding a new command key description pattern” on page 74|

* |“Exercise 7.2: Adding command key button labels” on page 77|

Time required

This module will take approximately 10 minutes to complete.
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Exercise 7.1: Adding a new command key description pattern

The prefix for the command key description in the SLTCUST record format is
Fkey=.

N iy

Coulthard, Phil
Gunaoabeesoon, Satish

Eair, Jirn 1

Coulter, Simon S
Masri, Maha
Llames, Joe L

This doesn’t follow the CUA rules normally used in iSeries user interfaces, so the
WebFacing conversion does not recognize this pattern and does not hide it. You
have to add this prefix pattern to the WebFacing Tool conversion rules in the
WebFacing Properties dialog.

To add a new command key description pattern to WebFacing conversion rules:
1. In the WebFacing Projects view, right-click your WebFacing project wflabxx.
2. Click Properties on the pop-up menu.

==
3
QpER
Open With y [TD)
D)
fidd 0)
Delete..,
Shyle »
Convert
View Log
Deplay
Team »
Compare With +
Restore from Local History, ..
Migrate 2

T

The Properties for wflabxx dialog opens.

@ Properties for wilabxx
| =l Conversion
| i ommand Key Recognitior

0 g v oaLLn a0E
. Edit Code Options

.| -MNUDDS Options

| ‘- ¥ML Record Metadata

3. In the left pane of the Properties for wflabxx, under Conversion, select
Command Key Recognition Patterns.

The right pane will switch to Command Key Recognition Patterns.
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o

7.

Next, you will test this feature by converting the DDS member and running the

Command Key Recoanition Patterns

Command keys will be displayed as buttons in your Web application. You can identify the text on these
buttons by specifying recognition patterns.

WebFacing parses the text constants on each screen to identify the Four-part recognition patterns:
<prefiv > <key number > <separator > <text string>. Then it labels each command key button in your
‘web application with the detected text stting, Many applications use only one recognition pattern.

~Example
& green-screen application that uses the prefix "F" and the separator "=" can be converted like this:

F3 = Reburn ---s-ssmmmmcmmmneaee = becomes

Select or type the prefixes (such as CA or PF) and separator (such as = or :) that appear on your green

screens, Add them to the table below,

Separator: ‘ | E 5 > I
 Prefix | Separator | Dok
o = __ bote |

Fhey I Move Lp I
[

Move Down I

Select an option to handle the detected text string for the command keys shown in the application area:

F

+ Remove text

" Keep text

(" Replace text with button for all records

" Replace tesxt with button for window recards

In the Prefix list, type Fkey

In the Separator list, leave =

Click Add to the right of these two lists.
The additional rule is now part of this style.
Click OK.

application.

Reconverting DDS members

Since these are conversion properties you are changing and not style properties as

in the previous module, you will need to reconvert all members that contain

command key descriptions with this pattern. In the sample Order Entry application
this is only member SLTCUSTD.

To reconvert DDS members:

1.

In the workbench in the WebFacing Project view, expand the wflabxx project, if

not already expanded.

Expand the DDS folder, if not already expanded.
Right-click the SLTCUSTD member icon.

Click Convert on the pop-up menu.

After the conversion, take a look at the change.

Testing the applied new rule

Let’s see how the new rule is applied to your WebFacing application.

To test the applied new rule:
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1. Right-click index.jsp in the WebFacing Projects view.

2. Click Run > Run on Server on the pop-up menu.

3. Go to the browser pane and click the Order Entry link.
You will see the first screen of the sample application.

4. Click Prompt or press F4.

The Customer Selection list window opens.

Pr'ts Order Entry

Type choices, press Enter.
2~Change [ —

Customer number . ......
To select custa

Click on link to select

Customer
Dakley, Ar_mie Q

i

Note: Notice that the command key text Fkeyl2=Cancel is gone from the
bottom of the window.

5. If the push button still shows, restart the Application server.
a. Click the Servers tab at the bottom of the workbench.

sty | olrs e settngs | Tnensts [EPROPE L |
) 505 .=

Server | Host name | status

ﬁi’d;bﬁphare 6.0 Server @ localhost  localhost B _Started

b. Right-click the server icon.
c. Click Restart > Start on the pop-up menu.
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Styles | Colors | Web Settings |Thumbneils M\Unkﬂ =2
Server | Host name | Status | St

‘WebSphere v6.0 Servep@localbost localbos [

= Stop
$-7 Disconmect

* LI Publish

2 Profile

d. Run the application again.

6. Select a customer or cancel by pressing F12 to return to the Order Entry
Application window.

Now that you know how to change the command key recognition patterns in the
WebFacing Tool, you can add text to frequently used command keys that don’t
have a text description in the DDS source.

—_—
mEntar T¥p
mEyit 2

B Prompt c
mHELP

Back on the Order Entry panel, you can see that the push button for F12 does not
have a description. Its label shows F12. You will learn how to fix the label in the
next exercise.

You have started the Properties dialog, selected Command Key Recognition

Patterns, added a new command key rule and reconverted the DDS members,
tested the applied rule, and now you are ready to begin [“Exercise 7.2: Adding]|
[command key button labels.”|

Exercise 7.2: Adding command key button labels

Before you begin, you must complete [“Exercise 7.1: Adding a new command key]
[description pattern” on page 74/

The WebFacing Tool allows you to specify command key descriptions for
command keys that are commonly used in your application but not described in
your DDS source and on your screens. This way the push button labels on the Web
pages can automatically be changed during conversion to the correct text. You will
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add the description Cancel to the WebFacing conversion properties so the push
button will get created to show a Cancel label instead of F12.

To add command key button labels:
1. Right-click your WebFacing project wflabxx.

- MebFacing Projects X Navlgabor[ ==

- L 2pen

E% pr. o Wit .
i @ NTD)
e pelete.., ST0)
-2 RTD)

C@ UL Convert
#8595 Viewlog

-[@] int

] lot Beplay
Team 3
Campare With »

Restore From Local Histaory. ..

et Ty S —

2. Click Properties on the pop-up menu.
The Properties for wflabxx dialog opens.

3. In the left pane of this dialog, under Conversion select Command Key Button
Labels.

In the right pane of this dialog, the Command Key Button Labels opens.

@ Properties for wilabxx . 5]
[=)- Conversion Command Key Button Labels
| Command Key Recogrition
Command Key Button Labe  This page allows you to modify the style of all command key buttons displayed in your WebFacing
- Edit Code Options application.
MNUDDS Options
. ¥ML Record Metadata UUse this page for command key kext that will not be identified by the recognition pattemns on the
di nun Tune previous page, Select the key and the button label you want to use, and add it to the table below.
= Project
< Order Entry Application
e ———..
e - | EE— [
- UIM Object Mippings Sommand fory @ Sn s - @
Web
B SME)D‘S e Command Button label
r
DOS Field Display Attribute Ll iz Delete
- Window
Subfile ove o
Command Keys
Move Down
IF the keyword for the DDS command key has a text parameter, that parameter will be used in place
of the button |abel specified on this page. If no label is Found or specified in this wizard, in CODE
Designer, o in the keyword parameters, WebFacing will use the keyword [kself a5 the button labsl,
4 i I LI for example, CFOS or CAD3,

| OK I Cancel

4. Under the Command key list, select F12.
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Under the Button label list, select Cancel.
Click Add to the right of these two lists.

The additional label is now part of the WebFacing conversion properties for
this WebFacing project.

Click OK at the bottom of the Properties dialog.
Next, back in the workbench, convert the changed application.

Reconverting DDS members

To convert the application in the workbench:

1.

Expand the wflabxx project if not already.

2. Expand the DDS folder if not already.
3.
4. Click Convert on the pop-up menu.

Right-click the ORDENTD member icon.

After the conversion, take a look at the change.

Testing the new label

Let’s see the new label for the F12 push button in your WebFacing application.

To test the new label:

1.
2.

> w

© N o O

Right-click index.jsp in the WebFacing Projects view.
Click Run > Run on Server on the pop-up menu.

Order Eng Rp‘pﬂ ce

BEnter Type choices, press Enter,
mExit 2=Change
BPrompt
Customer number ... .... [
mHELP

4| |

Go to the browser pane and click the Order Entry link.

Check that the Cancel push button on the first page now shows the correct
label as shown.

If the push button still has the old text, restart the Application server.
Click the Servers tab at the top view in the workbench.

Right-click the server icon.

Click Restart > Start on the pop-up menu.
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Styles | Colors | Web Settings |Thumbneils M\Unkﬂ =2

= Stop

&1 Disconmect £ Profile

9. Run the application again.

You have changed the text for the F12 command key, reconverted the DDS
members and tested the command key label.

Module recap

You have completed [Chapter 7, “Module 7. Adding command key rules and|
[labels,” on page 73] You have learned how to:

e Start the Properties dialog

* Select Command Key Recognition Patterns
e Add a new command key rule

* Reconvert the DDS members

* Test the applied new rule

* Change the text for the F12 command key
* Reconvert the DDS members

* Test the new command key label

Now that you have a Web user interface so the green screen look doesn’t show
through as much as after the first WebFacing conversion you did in k fhapter 3,|
[“Module 3. Converting selected source members,” on page 27} you want to add
some more refinements to the appearance of your Web pages. Continue to
[Chapter 8, “Module 8. Working with more style properties,” on page 81
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Chapter 8. Module 8. Working with more style properties

This module teaches you how to change the user interface further, using style
properties. You will learn to work with WebFacing Tool style properties and check
the changes by refreshing the style and running the application.

In this module, you will:

e Start the Properties dialog

* Change the window style

* Change the subfile style

* Change the command key style
* Test the changed properties

Since a style is used on a project level, all Web pages in your project will contain
the changes you apply to a particular style.

Exercises

The exercises within this module must be completed in order.

» [“Exercise 8.1: Starting the WebFacing properties style dialog”]

* |“Exercise 8.2: Changing the appearance of the subfile” on page 83|

* |“Exercise 8.3: Customizing the appearance of command keys” on page 85|

* [“Exercise 8.4: Checking the new style” on page 86|

Time required

This module will take approximately 10 minutes to complete.

Exercise 8.1: Starting the WebFacing properties style dialog

First, you will use the WebFacing Style properties dialog to tailor your Web user
interface. You will apply changes to the window layout of your screens, the subfile
appearance will be changed, and you will enhance the command key push button
looks.

To start the WebFacing properties dialog:

1. Start the product and open the WebFacing perspective, if it is not up and
running already.

2. In the WebFacing Projects view, select the wflabxx project.
3. Right-click the wflabxx project, and click Properties on the pop-up menu.
The Properties dialog opens.
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(& Properties for wilabxx

|: Conversion
¢~ Command Key Recognition
Command Key Button Labe
Edit Code Options
-~ MNUDDS Optionis
< ¥ML Record Metadata
C Run ‘I'rne
B
- Order Entry Applicatiol
- DDS Object Mappings
- UIM Object Mappings
=) Style
- DDS Field Color
- DD Field Display Attribute

o

- 2lDrie
-~ Command Keys

i E

4. Under Style in the left pane of the Properties dialog, select Window.
The right pane of the Properties dialog shows the Window properties.

x
F1- Conversion Window
| Command Key Recogrition
Command Key Butten Labe & window is displayed in the application area to represent a DDS WINDOW recard, You can customize
- Edit Code Options the appearance of the window title, body and the color of the window shadow.
MNUDDS Options
|- XML Record Metadata Window areas:  [Tite =
=I-Run Time
Fi d
= Project lelih
Order Entry dppicatiol S i | © |
DDS Object Mappings
EpriMQbject Mappings Font: |comic Sans M3, Bold, 16 __I
| Web
B-Style
DDS Field Color - Background
DDS Field Display Attribute
- Window Color: | I— . |
Subfile Body
Image;
Command Keys I _I
Heneat I ;l
st | =
Border color: | |
| ——]

Select Title from the Windows areas list.

Under Foreground click the .. push button to the right of the Color field.
On the Color Chooser dialog, click Red.

Then click OK in the Color Chooser dialog.

The Window Properties page reappears.

© N o>
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9. Click the .. push button to the right of the Font field.
10. Select font Comic Sans MS, size 16.
11. Click OK on the Font dialog.
12. Under Background, click the .. push button to the right of the Color field.
13. On the Color Chooser dialog, click Green.
14. Click OK on the Color Chooser dialog.
The Windows properties dialog reappears.
15. Select Body in the Windows areas list at the top of the page.

@i Properties for wilabxx _El
1+ Conversion Window
| Command Key Recogrition
Command Key Button Lsbe 4 window is displayed in the application area to represent a DDS WINDOW recard, Vou can customize
Edit Code Options the appearance of the window title, body and the color of the window shadow.
MNLDDS Opkions
| XMLRecord Metadata Window areas: [Body @
=1+ Run Time
Fi aund
" E Project ki
Order Ertry Agpleatil | ol | . |
DDS Object Mappings
- UIM Object Mappings Fortt: |verdam, Regular, 8 J
Web
- Style ——— ——
DDS Field Color Background
DDS Field Display Attribute
- Window Color: | _I
Subfile Body
Command Keys _I
| —

ok | cancel |

16. In the Border color field at the bottom of the page click the .. push button to
the right of the Border color field.

The Color Chooser dialog opens.
17. Select Blue.
18. Click OK in the Color Chooser dialog.

You have started the Properties dialog, changed the window style and now you
are ready to begin [“Exercise 8.2: Changing the appearance of the subfile.”|

Exercise 8.2: Changing the appearance of the subfile

Before you begin, you must complete [“Exercise 8.1: Starting the WebFacing]|
[properties style dialog” on page 81)

To change the appearance of the subfile:
1. Back in the Properties dialog, under Style, select Subfile.
The Subfile properties page opens on the right pane of the dialog.
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@i Properties for wilabxux 1 ﬂ

[=)- Conversion Subfile
| Command Key Recogrition
Command Key Button Labe  The scroll bar is used to view subfile records in the converted Web page. Select background colors
- Edit Code Options and images to be used for the scroll bar elements and the subfile records.
MNUDDS Options =\

i #ML Record Metadata Subfile areas: !Suhflle record - odd row @
=~ Run Time:
T =
! B Project Background —
- Order Entry Applicatior Color: I 0 |

DDS Object Mappings i
- UIM Object Mappings Image: I _I
Web —_—
- Style Repeat: i P

Even row
DDS Field Color
DD Field Display Attribute

eoTand Keys

ok | comel |

2. Select Subfile record - odd row in the Subfile areas list.

3. Under Background, click the .. push button to the right of the Color field.
The Color Chooser dialog opens.

4. Select light yellow.

x

o [ FEEEEECEECT
| L] IO
I'I'I'I'I'llr'l"l'l' E CCCOCCCECT HE
& CERENERECCECC
CEENENCTEECT

Decimal: | 255 | 255 | 204

Hex:  |FF | FF |cc

I~ Transparent

oK | Cancel I

Tip: If you are interested in the hex value of certain colors as they are used in
the style classes, the Color Chooser dialog displays the hex values; see the
value "FF FF CC "

5. Click OK in the Color Chooser dialog.
You return to the Properties dialog.
6. Select Subfile record - even row in the Subfile areas list at the top of the page.
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@& Properties for wilabsx . 5]

(= Conversion Subfile

Command Key Recognition

Command Key Button Labt  The seroll bar is used t view subfile records in the converted Web page. Select background colors

- Edit Code Options and images to be used For the scroll bar elements and the subfile records.

MNUDDS Options
; #ML Record Metadata Subfile areas: ESuhflIe record - even row
=~ Run Time B

I Project Background .

; - Order Entry Application Color: m

DDS Object Mappings | I |
- JIM Object Mappings Image: ] —l Odd row

e
Web e
[ Evenrow

@

- Style Repeat: =
DDS Field Color — [ vl
DDS Field Display Attribute
- Window
Subfile
Command Keys

ok | concel |

7. Under Background, click the .. push button to the right of the Color field.
The Color Chooser dialog opens.

8. Select a light green.

9. Click OK on the Color Chooser dialog.

Now at runtime the odd and even records will be displayed with different
background colors. Next you will customize the appearance of the command
key push buttons.

You have changed the subfile style and now you are ready to begin
[Customizing the appearance of command keys.”|

Exercise 8.3: Customizing the appearance of command keys

Before you begin, you must complete |“Exercise 8.2: Changing the appearance of|
[the subfile” on page 83

To customize the appearance of command keys:
1. In the left pane of the Properties dialog under Style, select Command keys.
The Command Keys properties opens on the right pane of the dialog.
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3.

@i Properties for wilabsx _ B 5]

[=1- Conversion Command Keys
Command Key Recognition
Command Key Button Labe  This page allows you to modify the style of all command key buttons displayed in your WebFacing

- Edit Code Options application. =
e DS Olions Command key states: IDefault
¥ML Record Metadata
=~ Run Time Foreground
B Project
< Order Entry Application Colar:

DDS Obfect Mappings
UIM Object Mappings Fort: |‘l’°rdﬂ, Regular, 10 :I

i sm:veb Text indent in picels: [12
o0 P e B =[Pt |
ﬁd:ihi Display Attribute Sk ako I,q,hove — EI

il | \ Rollover
G - S

Image: ] button_up.gif

Repeat: |Nn repest
Position: |

el L

| OK I Cancel

Change the Foreground color for all three states of the buttons:
* Default

* Rollover

* Button down

Now you have finished customization.

Click OK on the Properties dialog.

You have changed the command key style and now you are ready to begin

[“Exercise 8.4: Checking the new style.”|

Exercise 8.4: Checking the new style

Before you begin, you must complete [“Exercise 8.3: Customizing the appearance of]

fcommand keys” on page 85|

Let’s see the new look of your application.

To check the new style:

1.

2.
3.
4

Right-click index.jsp.

Click Run > Run on Server on the pop-up menu.
Run the application.

Click Prompt.
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y Application
Parts Order Entry

Enter k Type choices, press Enter
u Cancel {b

o '.ilal-gél _

= Customer number . .. ...,

To select custe

Click on link to select

Customer
Oakley, &nnie O

Farr, George

Coulthard, Phil

Fair, Jim ]

Masri, Maha

bt
< | X

The application window shows different colors, and the subfile records are
colored. The command key push buttons change color, depending on their
state.

Note: If the text is still showing the old colors, most likely the browser has
cached the page and you need to close the browser window, and restart
the application. This will open a new instance of the browser without
cached content.

You have tested the changed properties.

Module recap

You have completed [Chapter 8, “Module 8. Working with more style properties,”|
You have learned how to:

e Start the Properties dialog

* Change the window style

* Change the subfile style

¢ Change the command key style
* Test the changed properties

You have tested your WebFacing application with updated style properties and
now you want to customize the style further by updating the look and feel for a
fictional company. Continue to [Chapter 9, “Module 9. Customizing the default]
[style,” on page 89|
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Chapter 9. Module 9. Customizing the default style

Development Studio Client is built upon WebSphere Studio Site Developer. Site

Developer contains editors for HTML and Cascading Style Sheet (CSS) files. When

you created the WebFacing Web project, you selected a default style to your

Web-enabled application.

This module teaches you how to customize that style, updating the look and feel

for a fictional company. You will change the color of the application and add a

company logo as shown below.

PageBuilder.jsp . weh Browser X

[ whlabxx Log | S gradient.css =)

[ hitp:jflocalhost: 5080/ wHabxxjwebfacing/WebFacng.da | B | ¥ = (o & | .
-

Type choices, press Enter
2=Change

Customer number ., ., .. .. ||

Done

In this module, you will:

Locate the existing style

View the design of the existing style

Import the company logo

Edit the style sheet to include the company logo

Edit PageBuilder.jsp to remove and resize fields for your logo
Change the color

© Copyright IBM Corp. 2001, 2005

89



Exercises

The exercises within this module must be completed in order:

* [“Exercise 9.1: Opening Pagebuilder.jsp”|

* |“Exercise 9.2: Importing the company logo” on page 91|

* |“Exercise 9.3: Editing the style sheet and PageBuilderjsp” on page 92|

Time required

This module will take approximately 15 minutes to complete.

Exercise 9.1: Opening Pagebuilder.jsp

First you open the JSP file called PageBuilder as you want to edit this file to add a
new company logo in a follow-on exercise. PageBuilder.jsp is the main JSP for the
WebFacing project.

To open the PageBuilder.jsp:
1. Open the product in the WebFacing perspective, if it is not already open.

2. Expand wflabxx > Style > gradient > chrome > html in the WebFacing Projects
view.

3. Open PageBuilder.jsp by double-clicking the file.
4. Click the Design tab to see the existing style, shown below.
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& webFacing - PageBuilder.jsp - 1M Rational Software Development 7 = =]
Fil= Edit Toolbar Insert JSP Format Table Frame Page Tools Nawigate Search Project
Run ‘Window Help

|5 s % |3-0-Q- 1 | [ webFacing

G- ]Ei Al [ I NS - EHremate Syste...
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£ T3 whabx || PageBuld  E - | body v | Standard ~
# [ CL Commands

[ DS
% UIM Help
g style
= C5 gradient
= apparea
== chrome
- 8] gradient.css
- [€] header.gif
|| header_end.gif
B2 html
- 5] CmdKeys.jsp
& PageBuilder.js
[ side.gif
E side_bottom.gif

‘1 i i bl imminim. I-=C =

T Properties 52 . Gallery| ¥t = 8|
= B

o+
-

|
|

(= I"EH

1
| body Background: Image: |
Text

Mormal: "I
Text: B : _ ] < | LS
viited lnks [ Design | Source | Preview | Jl
Web Set,., ﬁﬂmmbnak R N severs| 2 =0
All Files (*.%) =l
I;ageBdlcler....

< | [

| wflabsxfWebContentiw. . html/PageBuilder . jsp |

You will now change the style to reflect a fictitious XYZ Company.

You have seen the design of the existing style and now you are ready to begin

[“Exercise 9.2: Importing the company logo.”|

Exercise 9.2: Importing the company logo

Before iou begin, you must complete [“Exercise 9.1: Opening Pagebuilder.jsp” on|

page 90.

To import the company logo:

1.

2.
3.

The first step is to import the company logo. Select chrome in the WebFacing
Projects view, then click File > Import from the workbench menu.

Select File System in the Import wizard, and click Next.

On the next page of the wizard, click Browse and go to the C:\WFDEMO
folder and click OK.

Select the check box next to sample_header.gif in the right list.
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5. Make sure that the destination folder is set to
wflabxx/WebContent/webfacing/styles/chrome, where xx is replaced by your
unique team number.

e mpors x

File system

Import resources from the local File system. B
From directary: | C:\WFDEMO | Browse... |

(= WFDEMO

O | window.aff

Fiter Types... | Select Al Deselect Al
Into Folder: |wﬂabxijebContentjwehfacing,l'styles;'chn:ume Browse, .. |
Options:

[ Overwrite existing resources without warning
" Create complete Folder structure
' Create selected folders only

< Back I MNext > ] Finish I Cancel I

6. Click Finish. To import the header you must now edit the style sheet to
configure the header to include this image.

You have imported the company logo and now you are ready to begin
[9.3: Editing the style sheet and PageBuilder.jsp.”|

Exercise 9.3: Editing the style sheet and PageBuilder.jsp

Before iou begin, you must complete [“Exercise 9.2: Importing the company logo”|

You must now edit the style sheet to configure the header to include the company
logo that you just imported. Then you edit PageBuilder.jsp to resize the table to
add the new company logo. Finally you make further changes to the style sheet to
remove existing images (side_curve.gif and side.gif) and to change the color of
these areas of your application.

To edit the style sheet and then PageBuilder.jsp

1. Expand wflabxx > Style > gradient > chrome in the WebFacing Projects view,
right-click gradient.css and click Open from the pop-up menu.

2. In the Styles view, double-click .headc to edit that style.
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oo 0N oo

—_ -

5 25 - s &% - |[7 b v x

| Description | Media |
“Keooy Page properties
O thesidecurve
O theside

B, thesidebottom

heade | | ]
B headr

®5; theapp

O |aunchbutton

Thurnbnails i\styles ]Cnlors | Links | Servers ;Tasks

Select *Background.

Update the Image field to sample_header.gif and change the Repeat field to
No repeat as shown.

(B
=) *Font ‘ Background !
Font styles
. *Background Color [ & || =] /|
- *Text Layout
E Layout Image : |sample_header.gif B I
i - Margin .
Border Color Repeec:
Border Style Atkachment : I j
- Border Width
 padding Left : | Right =) [Fiel =
[=}+ Pasition : -
Floating Top : ITnp _'_I IFNe! :_]
i Clipping
- List
- COthers
| O I Cancel Apply
Click OK.

Save gradient.css by pressing CTRL-S.

Now you must edit PageBuilder.jsp.

Click the PageBuilder.jsp tab. Then go to the Source tab.
Change the table height to 100 and width to 1024.

Delete the first <td>...</td>.

Change:

<td class=headc colspan=4 rowspan=1 width="441" height="33">
to:

<td class=headc colspan=6 rowspan=1 width="100%" height="100">
Delete the next <td>...</td>.

This removes the extra fields in the table and resizes the remaining ones for
your logo.

Your code should now look like this:
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13.
14.

15.
16.
17.
18.
19.
20.

94 Development Studio Client:

<table id="<%=(String)session.getAttribute("Uniqueld")%> Table"
border="0" cellspacing="0"

cellpadding="0" frame="box" height="100" width="1024">
<tbody>
<tr>
<td class=headc colspan=6 rowspan=1 width="100%" height="100">
<%=request.getAttribute("ApplicationTitle")%>
</td>

Save PageBuilder.jsp.
Click the Design tab.

It should look as shown below:

@ webFacing - PageBuilder.jsp - IBM Rational Software Development Platfolm -II:I|E
Fil= Edit Toolbar Insert JSP Format Table Frame Page Tools Mavigate Sean:h Project
Run  Window Hdp
]._"j - | I |3 -0 - Q- £ | [ WebFacing
| G H !@ 47 J 1 = - EBremote Syste. .,
~
= WebFacing Projects X Nav‘ngator| = 0O || & pagebui... 82 _ & WwebBro... I”z &3
L% UIM Help 2l page  EJ - | body v | Standard ~
: LS St\l'E -
. =05 gradient ||
H (= apparea
== chrame : _
~ & gradient.css H
_-'E;headELQF :
- & header_end.gif
== htmd
----- EI CrndKeys.jsp
 '§ ﬂdegf
- & side_bottom,gif
[ side_curve.gif
b indese,jsp
E Iogm.jsp
Kl |
= praperties 53 Gelery|w
= L='~
Property | Value
=l Info
derived false
editable true
last modified  6/30/05 2:18 PM g -
inked False Design | Sourae | Preview | N
location C:\Documents and Settin... |5 Thumbnails 52 St}rieslcdorsl » =5
name PageBuilder. jsp
path JuflabxgWebContentfw... |||All Files (*%) =l
size 2799
PageBuilder....
1 |

Now update the color of the side by selecting the gradient.css tab again.
In the Styles view, double-click .thesidecurve.

Select *Background.

Remove side_curve.gif from the Image field, leaving it blank.

From the drop-down list next to the Color field, select the color gray.
Click OK again to update the Style property.
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21. Open .theside style from the Styles view.

22. Remove side.gif from the Image field, leaving it blank.

23. From the drop-down list next to the Color field, select the color blue.
24. Click OK again to update the property.

25. Save gradient.css by pressing CTRL-S .

26. Run the wflabxx application on the test server to see the new style, shown
below:

PageBuilder,jsp wilabx: Log | S| gradient.css =3

[ hitp:jflocalhost: 5080/ wHabxxjwebfacing/WebFacng.da | B | ¥ = (o & | .
-

™ yyeb Browser X

Type choices, press Enter
2=Change

Customer number ., ., .. .. ||

o

You will now update another style sheet to make changes to the buttons and
text.

Done

You have edited the style sheet to include the company logo and edited
PageBuilder.jsp to remove and resize fields for your logo.

Module recap

You have completed [Chapter 9, “Module 9. Customizing the default style,” on|
You have learned how to:

* Locate the existing style

* View the design of the existing style
* Edit the style sheet to include the company logo
* Edit PageBuilder.jsp to remove and resize fields for your logo
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* Change the color

You have customized the default style to update the look and feel for a fictional
company. Now you need to move the application into production and you need
the WebFacing application to prompt the users for signon information when it

starts. Continue to [Chapter 10, “Module 10. Adding authentication,” on page 97|
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Chapter 10. Module 10. Adding authentication

This module teaches you how to secure your application by forcing authentication
before the application is invoked.

In this module, you will:

e Start the Properties dialog

* Open the project run-time properties

* Change the signon properties for the order entry application
¢ Test the signon dialog appears

Exercises

The exercises within this module must be completed in order:

* [“Exercise 10.1: Removing the default user ID and password”|

* [“Exercise 10.2: Testing the authentication dialog” on page 99|

Time required

This module will take approximately 5 minutes to complete.

Exercise 10.1: Removing the default user ID and password

© Copyright IBM Corp. 2001, 2005

You will use the CL command properties page of the runtime to remove the
default user ID and password information.

In the WebFacing perspective in the WebFacing Projects view:
1. Right-click wflabxx project.
2. Click Properties on the pop-up menu.

The Properties for wflabxx dialog opens.

3. Under Run Time in the left pane of the Properties dialog, select Order Entry
Application.
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@& Properties for wflabxx

=) Conversion
Command Key Recognition
- Command Key Button Labe
- Edit Code Options

MNUDDS Options
%ML Record Metadata

: Applicatin
DDS Object Mappings
- |JIM Object Mappings

- DDS Field Color
- DDS Field Display ntml},e
- Window
----- Subfile
Command Keys

S

The Order Entry application properties pane opens.

& Properties for wilabxx i

=1 Conversion Order Entry Application
i Command Key Recognition
B i L3¢ ommand label; [Order Entry Application
MNLODS Optons CLcommand: | CALL ORDENTR
« ¥ML Record Metadata
=1-Run Time @verﬁde praject settings For this command
[l Project ; -
L. Ovder Eniry Bpphcatiol || Settings specified For this CL command:
DDS Object Mappings Host name; | TORASO7M Host part: | 4004 Change... |
- UIM Object Mappings
! Wweb {@Specfy 05400 signon values
- Style :
DDS Field Color e |
DDS Field Display Attribute
; Passward; |
Window
Subfile Canfirm password; |
Command Keys
¥ Handle as if DDS files are compiled with DFRMRT(*YES) optian
™ Use insert mode For keyboard text entry
T — "
A

4. Make sure the Override project settings for this command check box is
selected.

5. Uncheck the Specify OS/400 signon values check box.
6. Click OK at the bottom of the Properties dialog.
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You are back in the WebFacing Projects view. You have changed the
authentication behavior for this link (application). In this WebFacing project
you only have one link, but imagine that you have multiple entry points into
your application like a menu. You could specify a different authentication
behavior for each of these links. On the other hand, if you have multiple links
in a WebFacing project and the authentication should be the same for each
different link, then you can specify an authentication rule on the project level.
To do this, just go to the project properties page instead of the CL command
properties page and specify the desired authentication behavior there.

You have started the Properties dialog, opened the project run-time properties and
changed the signon properties for the order entry application and now you are
ready to begin [‘Exercise 10.2: Testing the authentication dialog.”|

Exercise 10.2: Testing the authentication dialog

Before you begin, you must complete [“Exercise 10.1: Removing the default user ID|
fand password” on page 97|

As before, you run your application in the WebSphere Application Server Test
Environment.

To test the authentication dialog:
1. Right-click index.jsp.
2. Click Run > Run on Server on the pop-up menu.
3. Click the Launch link.
You will see the authentication dialog.

Please type your user name and password,

User Mame: I
Password: I

4. Specify your User Name and Password.
5. Click the Logon push button on the Authentication dialog.

The application will run like before, if the job environment for the user ID you
specified is setup correct for this application.

6. If the LOGON dialog doesn’t appear, restart the Application server.
a. Click the Servers tab at the top view in the workbench.
b. Right-click the server icon.
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c. Click Restart > Start on the pop-up menu.
d. Run the application again.

You have tested that the signon dialog appears.

Module recap

You have completed [Chapter 10, “Module 10. Adding authentication,” on page 97|
You have learned how to:

e Start the Properties dialog

* Open the project run-time properties

* Change the signon properties for the order entry application
¢ Test the signon dialog appears

You have created a WebFacing application and now want to enhance the look of
the index.jsp page to give the start page of this application a professional
appearance. The workbench contains several tools to design and enhance Web
pages. Also with the workbench you have access to sample pictures, icons,
animations, and more. You will use some of these tools and samples and enhance
the page so it becomes more attractive. Continue to [Chapter 11, “Module 11
[Enhancing index.jsp page,” on page 101
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Chapter 11. Module 11. Enhancing index.jsp page

This module teaches you how to use the Web tools in the workbench to update the
index.jsp file. The index.jsp file created by the IBM WebFacing Tool that allows you
to start your WebFacing application is plain. In this module you will add some
color to it, as well as some pictures to make it a more interesting Web page.

In this module, you will:

Open the application start page (index.jsp) in Page Designer
Change the window title to Order Entry

Add a style to the Order Entry Web page

Start WebArt Designer

Add a logo

Resize the logo

Save the logo as a WebArt object

Save the logo for a Web page

Place the logo on the Design page

Insert a heading below the logo

Add a picture to the Order Entry Web page

Add a marquee to the Order Entry Web page
Change the color of the window title

Remove default text added by the WebFacing Tool

Exercises

The exercises within this module must be completed in order.

[“Exercise 11.1: Opening Page Designer”]

[“Exercise 11.2: Working with page properties” on page 103|

[“Exercise 11.3: Linking a cascading style sheet to a Web page” on page 104|

[“Exercise 11.4: Designing and adding a logo” on page 106|

[“Exercise 11.5: Adding a heading 1 tag to the page” on page 115|

[“Exercise 11.6: Adding a picture to the page” on page 117]

[“Exercise 11.7: Adding moving text to the page” on page 118|

[“Exercise 11.8: Changing the text color” on page 124|

[“Exercise 11.9: Deleting default text from the page” on page 125|

Time required

This module will take approximately 30 minutes to complete.

Exercise 11.1: Opening Page Designer

To open Page Designer:

1.

Open the WebFacing perspective, if not already open.

You should now have the WebFacing Projects view in your workbench
environment.
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E:---E,,, wilabxx
- [; L Commands
=2 pos
- (o <s400a>WFLABXY/QDDSSRC{ORDENTD)
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2. Expand the wflabxx WebFacing project.
3. Right-click the index.jsp icon.
4. Click Open on the pop-up menu.

The Page Designer opens in the upper right pane of the workbench and shows
the index.jsp page as the WebFacing Tool created it.

(At B wiabxx... | S| gradien... l”: 8
index.jsp - Untitled Fl~ | eobv - | standad ~

Select program to start

]
2 1 4
¢ i
:(.?.-.....,....,....,....,....,....,....,....,....,..................................,....,.......,....,.,....,\:

Iw Source ] Preview [

Make sure that you are on the Design page in Page Designer.
5. Click the Design tab.
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You have opened the application start page (index.jsp) in Page Designer and you
are ready to begin [“Exercise 11.2: Working with page properties.”]

Exercise 11.2: Working with page properties

Before you begin, you must complete [“Exercise 11.1: Opening Page Designer” on|

Next you move the links down.

To work with page properties:
1. Click before the Select program to start title.
2. Press the Enter key a number of times.

@ *ndex.jsp X WE=LL e |S_.gradlanu. |”1 8
index.jsp - Unttled * = El~| p+ | standad ~
d
ok
J

Select program to start

—————————————————————————————————————————————————————————————————————————

Design | Source | Preview |

3. Right-click the background of the index.jsp page in Page Designer.
4. Click Page Properties on the pop-up menu.
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o ‘ Paste
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Save
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Insert
5P »
d :
47 Insert Link... Chrl+Q
: Style ! ’
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: Embedded Document 4 2
free e s Switch Active Document. ., :
oo [l Properties CobaeEnter |
st Layout Mode >
= Rur to Line Chrl+H

= Add to Snippets, .

Design [ Source [Previ | = i Events

The Page Properties dialog opens.
x

Page Information | Meta Info | J5P Tags |

Page title: | Order Entry

Base URL: | E\ﬁ

Default target: | :_I
Encoding: S0 10646/Unicode(UTF-8) :J

oK I Cancel

5. In the Page title field, type Order Entry.
6. Click OK on the Page Properties dialog.

When this page is shown in a browser, the Window title bar of the browser will
now display Order Entry.

You have changed the window title to Order Entry and now you are ready to
begin |“Exercise 11.3: Linking a cascading style sheet to a Web page.”]

Exercise 11.3: Linking a cascading style sheet to a Web page

Before you begin, you must complete [“Exercise 11.2: Working with page]
[properties” on page 103|
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Now you will add a style to the Web page. You can use a style that is used in your
company or you can use one of the sample style sheets that are provided in the
product.

Next you open the Gallery view in the workbench.

To link a style sheet:

& webFacing - index.jsp - IBM Rational Software Development Platform (=] P3|
File Edit Toolbar Insert J1SP Format Table Frame Page Tools Nawgabe Search Project
Run ‘Window Help

1:1.7 = I.TﬁTJ J J g Jﬁ Q-Q- 59 | [ webFacing
] (3 H ] = 5 J T v Efremote Syste. .,
[BwebFacing ... £ Navlgab:lr| =if & *index.jsp £2 [ wlabxx... [”’3 = ﬁ\
55 153 whabix indexjsp- El~| P v | Standad -
# [ CL Commands
CREN 0 4
# L2 UM Help d
L5 style - i
indesx. jsp J dl
“[&] logon.jsp
A
)\
F
F
(s
jé
r
(-84 Image
22 @ Webart
= m
-

=

Click the Gallery tab, if the Gallery view isn’t already displayed.

Scroll to the bottom of the Gallery view, until you can see the Style Sheet icon.
Click the Style Sheet icon, to select it.

Click the Thumbnails tab on the right bottom pane in the workbench.

You should see thumbnail icons of all the styles available.

PoODd -~

5. In the thumbnail view, scroll down to the bottom, until you see style sheet
waves(001.css in the list, or select a style sheet that you like best.

6. Click the thumbnail picture of waves001.css with the left mouse button.

Chapter 11. Module 11. Enhancing index.jsp page 105



7. Hold the left mouse button down and drag the cursor to the Page Designer
window.

®

8. The cursor will change from this shape , to this shape . When the
latter cursor shape appears in the Page Designer window;, release the left mouse
button.

After a short while the Style sheet properties will be applied and the colors in
the page will change to the style sheet definitions.

[51 pageuil... ‘ & web Bro... . B whlabxx ... | S| gradient,.. g
index.jsp - Order Entry * - Fl~| | standard ~

Select program to start

e RN A A R AR AR EAEEEEAE NSNS NARASAAEAREASAEEsmEsmEs s

Design | Source ] Preview |

You have added a style to the Order Entry Web page and now you are ready to
begin [“Exercise 11.4: Designing and adding a logo.”|

Exercise 11.4: Designing and adding a logo

Before you begin, you must complete [“Exercise 11.3: Linking a cascading style|
[sheet to a Web page” on page 104

Now that you have the overall Web page look specified, you will use the WebArt
Designer to create a Logo that you then will add to this page.

Starting the WebArt Designer

To start the WebArt Designer:
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@ webFacing - index.jsp - IBM Rational Software Development Platform -10] x|

Fil= Edit Toolbar Insert JSP Format Table Frame Page | Tools Mavigate Search Project
Run Window Help

Launch External Web Browser »
lrse@ | o |6 % [ %5~ Q - Q - 2bispelCheck.. Shift+F7
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4 \; CL Commands
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1. Click Tools in the workbench menu.
2. Click WebArt Designer on the pop-up menu.
The WebArt Designer opens.

@ Untitled - WebSphere Studio WebArt Designer P -0 x|
Fil= Edit Wiew Object Tools Help

AR E Ere mlm@@@mﬂ@?m

| B0 @y
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Enter text, and then insert an object ko the Canvas, [ |

A4

The WebArt Designer shows the Template Gallery on the left, where you find
samples of logos, buttons, rollovers, images and more. The big white area in
middle of the dialog is the canvas that is used to work with objects that you
want to create or change. Although you could select a logo from the template
gallery as the base for your own logo, you will instead create you own.

Creating the logo

To create the logo:

1. Click the Create Logo button above the canvas or use the Object > Create

Logo menu options.

¥% Untitled - WebSphere Studio Webart Designer 1ol x|
File Edit View Ob s Tools  Help

| oS EB| ¥ e X ik o
|sEe @ @y

Elllz ==l <R Y =1

The Logo Wizard opens.
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Logo Wizard {Specify Text - 1/4) _)s]

Text:

lwﬂf:'ellbuu ZI IBA{
A lwflabxx

-~ Font

Font name: :J

Font size:

s;:n::ing: i i sp;;c::er =

[ Shikethrough < Right
[™ Underine Divection
W Antisiias ‘7 [ Vertical

< Back I Nest > I Cancel I Help I

2. Enter your company name in the Text field and in the next line of the Text
field enter the project name.

Select Comic Sans MS in the Font name list.
Select 46 in the Font size list.

Under Style, select Bold and Italic check boxes.
Leave the Antialias check box selected.

N O s~

Click the Center radio button under Alignment.

Notice in the upper right corner of the dialog, a sample of the logo is
displayed.

8. Click Next to go to the next page of the wizard.

The Select Color page of the wizard opens.
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Logo Wizard {Select Color - 2/4) .3.'

 s(@e)

List:

<Back Next > Cancel |  Hep |

9. Click the gradation Type push button, the middle one of the three type push
buttons.

Note: The other push buttons select color types: solid and textured.

10. Select beer from the colors available, or any other color you like best, just
scroll through the list to find a gradation you like.

Tip: You can change the colors by clicking the Others push button on this
dialog and create your own gradation.

11. Click Next to move forward to the next page.
The Select Outline page opens.
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Logo Wizard {(Select Outline - 3/4) E’

~ Options
Edgevidh T/

Edge color: -l

Transparency: s I UE: %

|||||||||||

Bulge for edge: ’g- il

I3

<Back Next > Cancel |  Hep |

12. Select the Seal outline from the list, or any outline you like best.
13. Click Next.
The Select Text Effect page opens.

Logo Wizard {Select Text Effect - 4/4) - ll

~ Options

Embossment

strength:

Embossment
direction:

<Back Cancel |  Hep |

14. Select the Emboss text effect or one that you like best.
15. Click Finish.
You return to the WebArt Designer window with the new logo object.
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Resizing the logo

To resize the logo object on the canvas:
1. Click the logo object to select it.

2. Move the cursor to the rectangle at the right bottom corners of the object,
watch the cursor changing shape.

3. Drag the rectangle up and to the left so the object becomes smaller.

Now you need to save this object. First you want save it as a WebArt object,
that allows you later on to work with the object again in WebArt Designer.
However you can’t use that format for your Web page, so you will also save it
in another format.

Saving the logo as a WebArt object

To save the logo as a WebArt object:

1. Click File on the WebArt Designer menu.

2. Click Save Canvas As on the pop-up menu.
The Save Canvas As dialog opens.

Note: Make sure you save the canvas in your workspace.

2]
Save in | (3 WebContent JJ & 1) m'f --
S META :é_f’ﬁl) esktop W
" Jthemd E’]‘ Ay Cmpt.‘ta
—m = Local Disk [C:)
—I webfz (] Dacuments and Settings
_IWEB- ] Adrinistratar
C11BM
[ rationalsdpB.0
() whabss
] wihlabss
wehContent

= New Volume [D:]

@ Compact Disc [Z:) j
- |
Saveas| @ My Metwork Places M

] Application Data

File name
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20

Save in: I {3 WebContent :J & @ % E-

_IMETA-INF
| Itheme

| lwebfacing
| WEB-INF

File name: (!m}llagd ) l@]
Save as lype: IWehﬁ‘-\rt filess [+ mif) =l Cancel |

I™ Include Canvas

4

3. Type mylogo in the File name field.

4. Click Save.
Now you save the object in a form that can be displayed on a Web page.

Saving the object for a Web page

To save the logo object for a Web page:
1. Click File from the WebArt Designer menu again.
2. Click Save Wizard for Web on the pop-up menu.
The Save Wizard dialog opens.

Save Wizard (Specify Objects) - 1/3 [ _}_(_j

¢Back Newt > Cancel | Heb |

3. Leave the Save the selected objects radio button selected.

4. Click Next.
Now the Select File format page opens.
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x
Select a format for the image file. %
@ Thiz format can handle onlp 256 colors, By saving an image as a
GIF file, you can reduce its file size. This format is suitable for
images that do not require many colors, such as line drawings or
raphs.
anu can make pait of an GIF image kiansparent.

" JPEG |This format is in general use on the Internet because of its small file
size and inconspicuous image degradation.  This format is suitable
for full-colar images, such as photos taken with a digital camera.,
You cannot make a part of a JPEG image transparent.

" PNG  |This format maintains the quality of an image, but the file size
becomes larger than that of a JPEG. This format is suitable for
full-color images whose quality is important, such as computer
graphics.

"You can make a pait of a PNG image transparent; however, only a
fews browsers can handle it comectly.
ok [(Ton )| _Coca |t
5. Leave the GIF radio button selected.
6. Click Next.
The GIF Format page opens.
Save Wizard (GIF Format) - 3/3 l(_l
[Driginal image] [Image to be saved]
LJ L

File size before: 10716 bytes
File size after: 2768 bytes
~ Palette — Properties
€ e the palette far the curent file W Transparent g;l
% Use the optimized palette I~ Interlace
Colors: IESB cdiore j' ~ Background color

Dither

Yes >

Il:dnl of the Carvas ¥ I

Coee | _ et

7. Click Finish.
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The Save As dialog opens.

S-B\fein;liﬂ WebContent _"J & @ e E-

2]

_IMETA-INF

| Itheme

| Iwebfacing
| WEB-INF
gwavesﬂll?bu

File name: @

Save as ype: |GIF files [*.gif]

8. Type mylogo in the File name field.
9. Click Save.
Next you close the WebArt Designer.
10. Click File from the menu.

11. Click Exit on the pop-up menu.

You are back in the workbench in the WebFacing perspective showing the

WebFacing Projects view.

Next you switch to the Navigator view to locate the logo object mylogo.gif

and to place the logo on the Design page.

Note: You may have to click Window > Show view > Navigator from the

workbench menu.
Placing the logo on the Design page

To place the logo on the Design page:
1. Click the Navigator tab.

2. Expand the wflabxx Web project if not already expanded.
3. Expand the WebContent folder if not already expanded.

WebFacing ... e
| Bg -
| 8] Uparrow, gif ﬂ

. B gz chrome
e (8] sample.,gif
-|#] transparent.gif
# = UIMHelp
¥l = WEB-INF
[ﬂ image.qif

- §| wavesO01.css
[ﬂ waves002bu, qif
== ‘Web Diagrams
= .classpath
Lcompatibility

ﬂ lrl:J

R

The mylogo.gif file should appear in the list. If it doesn’t appear, refresh the

list.
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4. Right-click the WebContent folder icon.

5. Click Refresh on the pop-up menu.

Hopefully you can see the file now in the Web Content folder; if not, go to
Windows Explorer and search for the mylogo.gif on your hard drive. Move it
to the Web Content folder in the product workspace. If you didn’t use the
default workspace location, do a search for the workspace and the wflabxx
directory in it. Move the mylogo.gif into the WebContent directory under the
wflabxx directory. Refresh the Navigator view again.

Now you can take the logo and put it on your Web page that is still open in
Page Designer. If Page Designer has been closed just open the index.jsp file.
Make sure you are on the Design page, not the Preview page.

In the Navigator view, select the mylogo.gif file.

Hold the left mouse down.

Drag the file to the upper left corner in the Page Designer window.

© 0N

Release the mouse button.
The logo is placed on the Design page.

WebFacing ... ."-‘;_T.I\I.avigator SE\\\D g M * i
% w || index.jsp - El-| me ~ | standad -
&) Uparrow.gif ﬂ ]

L
| B5= chrome m
o 8] sample.qif = -i¥ -
A & transparent,gif ,m
#4= UIMHelp P )

[ (= WEB-INF o
[&] image.gf

-] index.jsp % +
B wavesd0zns of Select program to

= ‘Web Diagrams = Sta l't

= .classpath

=] compatibilty '_vJ
_ﬂ [» o

You have started WebArt Designer, added a logo, resized the logo, saved the logo,
and placed the logo on the Design page, and now you are ready to [“Exercise 11.5:

[Adding a heading 1 tag to the page.”]

P> | £l &

[ -

Exercise 11.5: Adding a heading 1 tag to the page
Before iou begin, you must complete [“Exercise 11.4: Designing and adding a logo”)

Now you want to insert a heading below the logo.

To add a heading 1 tag;:
1. Position the cursor just below the Logo at the first BR tag.
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@ WebFacing - index.jsp - IBM Rational Software Development Platform™ -8 x|
File Edit Toolbar | Insert JSP Format Table Frame Page Tools Navigate Search Project

Run  Windaw Help 2 iy Ctr+Q
1% - & | # anchr... [ | [ webFacing
| @~ Image Fils » £ Remate Syste...
e Background Image File » = ~
WebFading .o |5 o oind Musie » [Fwlabxc... | 3 B3]
@ P - Standard ~
— [ Free Layout Table | | standr -

! LY

4= chr O Text Cel
e |

é ::: Paragraph d  Normal Ctr+0

s um U ' T
El = T Table... Chrl+T Heading 2 Chrl+ L

===

(& f"“age'_gf — Horizonkal Rule Heading 3 CirH+3 »*
-8 ndex.jsp Headng4  Ctri4 F
% mmy:ggﬁf:f Form and Input Fields L4 Heading 5 Ctr+5s [
- 8] waves001, ﬁz Script oakw g IE
o [€] wavesnozk — Address [
[ Web Diagrams ]__] Layout Box Elock Quotation I
=] .classpath
B et | LG BrESH Ctrl+Enter prefomaitsd .

2. Click Insert from the workbench menu.

3. Click Paragraph > Heading 1 on the pop-up menu.
A frame appears that allows you to enter text.

4. Enter your company name Order Entry Application.

f@ PageBuil... ] & Web Bro,.. @ *index.jsp X [E whlabxx ... | S| gradient,.. | =

indez. jsp - Order Entry * = " JE | H1 = | Standard ~

&
(yflabioig

o

IBM Order Entry Application

Select program to start

: :
\ E )
L T T e T T s rl
: :
(3 )
| :
:-"T ------------------------------------------------------------------------------- H
s ;

................................................................................ .
Labl L

Design | Source | Preview |
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Now you want to use one of the sample pictures included with the product
and place this picture on the page.

You have inserted a heading below the logo and now you are ready to begin
[“Exercise 11.6: Adding a picture to the page.”]

Exercise 11.6: Adding a picture to the page

Before you begin, you must complete [“Exercise 11.5: Adding a heading 1 tag to the|
[page” on page 115

To add a picture to the page:

@ webFacing - index.jsp - IBM Rational Software Development Platform I | x|
Fil= Edit Toolbar Insert JSP Format Table Frame Page Tools Navigabe Search Project
Run Window Help
J.T'EJ |5 ] %|3-0-Q- 5 | [ webFacing
| 69 . I RS et B LHremote Syste. .,
WebFacing ... |5 Navlgator i3 =5) & *index.jsp £2 . [B wlabxx... [”’3 =) ﬁ\
| 2% w | indexisp-  Elv | mt v | standard ~
b -1& IJpArmw :I Pt :I
- |ﬂ sample, gif i
- [] transparent.gif 4
- B UMHelp [
j ='- WEB-IMF
i |E| image. gif
Bl ndeegp IBM Order Entry
- & mylogo.gif
@ mylogo. mif = -
B soveoniss Application
- [&] wavesoozbu.gif
~[= Web Diagrams e
- |5 classpath 4’
<15 .compatibility -
J s
: . ™
Bicallery 23 "\ WebFac..|™1 =0 Select program to  —
=8 Image
i ("2 Banner Start
)T SN | o il et s P G
._ Buttan 5
i Icon
[ Tlustration |
3 Line DBsign|50ur Preview| J_l
i s[CJ Photo : =
E o5y Theme KENITTI I RE, Servers | Web Set..‘l”s 8
; ! [ Title |Image Files (*.gif,§ jpg,*.png,™.bmp,*.wmf,* emf,*.tF, |
(" Wallpaper -
. @ Webart < =
-l Multimedia ﬁ
82 Style Sheet
|| Page Template
00, gif i 006il, gif
s ol =
I |

In the workbench in the Navigator view, select the Gallery tab.
Expand the Image folder.
Select the Illustration folder.

In the Thumbnails view beside the Gallery view, select one of the sample
illustrations, for example, use file 005il.gif.

N
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Note: The sample illustrations change from release to release so 005il.gif might
not be available in your environment.

5. Drag a picture onto the Design page below the heading.
The Design page now contains a picture.

IBM Order Entry Application

Design | Source ] Preview |

You are almost done. Next you add moving text to the page.

You have added a picture to the Order Entry Web page and now you are ready to
begin |“Exercise 11.7: Adding moving text to the page.”]

Exercise 11.7: Adding moving text to the page

Before iou begin, you must complete [“Exercise 11.6: Adding a picture to the page”]

Now you add moving text to the page.

To add moving text:
1. Position the cursor in the Design page underneath the picture.
2. Click Insert from the workbench menu.
3. Click Paragraph > Heading 3 on the pop-up menu.
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4. Leave the cursor positioned inside the heading 3 frame.

Chapter 11. Module 11. Enhancing index.jsp page 119



@ webFacing - index.jsp - IBM Rational Software Development Pla

=10l ]

File Edit Toolbar | Insert JSP Format Table Frame Page Tools Navigabe Search Project

Run Window Help & Linka., Ctrl+Q
J -] J 47 anchor... 5 | [ webFacing
] [FA: A C J Image File 4 Efremote Syste. .,
Background Image File 4 - ~
of T 5 E
[ PageBuil... Background Music » abo ... | S| gradient. ., l
index.jsp - Order Er I H3 ~ Standard ~
-~ T Free Layout Table | | :l
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iz, e :
4 List >
4 1 Table.., Chrl+T
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{1 Layout Box
Line Break... CtrHEnter
Special Characters...
Non-breaking Space  CtrH-Shift+5Space
File...
Keyword. .,
Y Date and Time...
551 »
d [ Java Applet...
.............. Data ¥ HotMedia... .-
Page Tsrnplat? ‘ : <3 Plug-ns...
il wWeb Site Mavigation Object...
R ——| | Inline Frame. .. -
........................................................................ Style Container (DIV)L§ | |
SPAN with Style... i
----------------------------------------------------- SPAN i
_______________________________________________________ Comments. .. il
Design | Source | Preview | HTML Source...

|| whabxxjWebContentfindex.jsp |

5. Click Insert from the workbench menu.

6. Click Others > Marquee on the pop-up menu.

The Insert Marquee dialog opens.
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11.
12.

€& Insert Marquee

by
Ix

Text:
A ———
q Please select link ko start application D
~EBehavior —Repetition

Mwen‘-e". | Repett'n
Direction: | (Auto) - Cout; ®—

- Display speed - Size
Delay time: I Width: | Ipixels ;]
Scroll amount: I Height: | Ipixels ;]

[~ Use true speed

—Color

Background color: -I ;I il

Enter into the Text field, Please select Tink to start application.
Under Behavior, select Slide in the Movement list.

Under Repetition, select Finite in the Repetition list.

Under Repetition, type 1 in the Count field.

The two last selections just avoid the text sliding in forever and not standing
still. If you want more movement on the page you can change these settings.

Select Lime in the Background color list. Click OK on the Color palette.
Click OK on the Insert Marquee dialog.
The Design page should look like this.

Chapter 11. Module 11. Enhancing index.jsp page 121



(= PageBuil... l (&) wWeb Bro,.. B tindex.jsp X 1= [T ] S| gradient,.. | EN
index.jsp - Order Entry * = Fl v | marquee - | Stardard ~
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VIEH
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]

IBM Order Entry Application

]
(T ———
e Ty :]
Design J Source IPrwIew_]

Next you save some space by removing some of the line break tags.

13. Position the cursor on the BR tag.

14. Press the Delete key until the SELECT PROGRAM TO START title appears on
your page.
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& pageuil... | & Web Bro... @ *index,jsp X B whlabxx ... S| gradient... | =)
index.jsp - Order Entry * = 2]

C

II) Ilf}ll}

&
wfiabics

IBM Order Entry Application

Design | Sourceff Previen )

Next you look at the page, as it would appear in a browser.
15. Click the Preview tab at the bottom of the Design page.
You will notice that your heading 3 text is sliding in.

wiiataus

IBM Order Entry Application

€

{

SELECT PROGRAM TO START

You have added a marquee to the Order Entry Web page and now you are ready
to begin [“Exercise 11.8: Changing the text color” on page 124/
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Exercise 11.8: Changing the text color

Before you begin, you must complete [“Exercise 11.7: Adding moving text to the|
[page” on page 118

You notice that the Text color and the background are not easy to distinguish from

each other. One way of changing this, is to apply another color to a certain area of
the text. To do that you return to the Design page.

To change the text color:
1. Click the Design tab.

(Q Web Bro... [ *index.jsp &2 _[E wflabxx... ] S gradien... | ! ﬁ\

index.jsp - Order Entry * El~| soov » | standard ~

2l
&y}

Select program to start =

Design | Source | Preview[

swles]LInks|Thumbnals|5ervers|Web mttlr@\ & g <

B +ooooff - # | Background Color ~
Set as Table Background Color >

arotind of Layput Box

o

Select the company text (IBM) you want to change color on, by selecting the
text area with the mouse cursor.

Under the Design page, select the Colors tab.

In the Colors view, select a color with your mouse cursor.

Click the down arrow next to the Text Color from the Colors view.
Click Set as Text Color on the pop-up menu.

You are done; now the selected text will be displayed with the color you
selected for it.

ook~ w

You have changed the color of the window title and now you are ready to begin
[“Exercise 11.9: Deleting default text from the page” on page 125]
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Exercise 11.9: Deleting default text from the page
Before iou begin, you must complete [“Exercise 11.8: Changing the text color” on|

page 124,

Now you want to remove the default text that was added by the WebFacing Tool.

To delete default text from the page:

IBM Order Entry
Application

SELECT PROGRAM TO START

1. Select the text.
2. Press the Delete key.

3. Select the Preview tab to view your completed page.

Z4
wflobios

IBM Order Entry Application

€

{

SELECT PROGRAM TO START

N

. Close the file index.jsp.

o

Click Yes to save the changes.
Page Designer is closed.

o

In the Navigator view or WebFacing Projects view, right-click index.jsp.
Click Run > Run on Server on the pop-up menu.

N
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Your new designed index.jsp page opens and you can run your application.

164
(flabon

IBM Order Entry Application

SELECT PROGRAM TO START

L] Order Entry Application

You have removed the default text added by the WebFacing Tool.

Module recap

You have completed [Chapter 11, “Module 11. Enhancing index.jsp page,” on page|
You have learned how to:

* Open the application start page (index.jsp) in Page Designer

* Change the window title to Order Entry

¢ Add a style to the Order Entry Web page

* Start WebArt Designer

e Add a logo

* Resize the logo

* Save the logo as a WebArt object

* Save the logo for a Web page

* Place the logo on the Design page

* Insert a heading below the logo

* Add a picture to the Order Entry Web page

* Add a marquee to the Order Entry Web page
¢ Change the color of the window title

* Remove default text added by the WebFacing Tool

After creating and testing your completed WebFacing application, you can deploy
the WebFacing application, if you have WebSphere Application Server Express
installed on your iSeries server. If you want to deploy your WebFacing application,
continue to [Chapter 12, “Module 12. (Optional) Exporting to iSeries WebSphere]
[Application Server Express 6,” on page 127
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Chapter 12. Module 12. (Optional) Exporting to iSeries
WebSphere Application Server Express 6

You have tested the WebFacing application in the WebSphere Application Server
Test Environment and you are ready to move it to your iSeries WebSphere
Application Server production environment. You are running WebSphere
Application Server Express Version 6 on your iSeries server.

This module teaches you how to publish your WebFacing files to a remote
WebSphere Application Server Express 6 environment on an iSeries host. In this
module, you will learn how to:

* Map a network drive

* Open the Export wizard

* Export the EAR file

* Start an existing HTTP server console

* Install and manage the application

* Run the application on the production server

Exercises

The exercises within this module must be completed in order:

* |“Exercise 12.1: Mapping a network drive”]

+ [“Exercise 12.2: Exporting your EAR file” on page 128

* |“Exercise 12.3: Installing the application” on page 130

* [“Exercise 12.4: Testing the WebFacing application” on page 136|

Time required

This module will take approximately 30 minutes to complete.

Exercise 12.1: Mapping a network drive

First you copy the WebFacing project files to a WebSphere Application Server,
Version 5.1. These first steps are the same for WebSphere Application Server for
iSeries, Version 5.1 and the WebSphere Application Server for iSeries Express,
Version 5.1.

Before you export any files, you must map a network drive to the Root file system
on the iSeries where WebSphere Application Server is installed.

To map a network drive:

1. Right-click the Network Neighborhood or (My Network Places) icon on the
desktop.

2. Select Map Network drive on the pop-up menu.
The Map Network Drive dialog opens.
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Map Network Drive il
‘Windows can help you connect to a shared network Folder
and assign a drive letter ko the connection so that vou can
\’ access the folder using My Computer,
=
e | Specify the drive |etter for the connection and the folder
that you want to connect to:

Folder: | 11s4002\Q18M | erowse... |

Example: \iserverishare

I” Reconnect at logon

Connect using a different user name,

Sign up for online storage ot connect to a
nebwork server,

<ok [ Fnish | cancel |

3. In the Folder field, enter two backslashes \\ and the Netserver name of your
Web server, and then \QIBM, for example: \\S400A\QIBM.

4. Click Finish.

You now have an additional drive available on your workstation and are ready
to export your WebFacing project files.

You have mapped a network drive and opened the Export wizard and now you
are ready to begin [“Exercise 12.2: Exporting your EAR file.”|

Exercise 12.2: Exporting your EAR file

Before you begin, you must complete [“Exercise 12.1: Mapping a network drive” on|
iae 127.

The J2EE standard has the concept of an Enterprise Archive File (EAR). This file is
a zip file that contains all information about your Web application. In the
workbench, this file is built automatically for Web projects. Since your WebFacing
project is a Web project, the wflabxxEAR file exists already. You only have to move
it to the application server, point to it, and then install the application. There is no
need to know about the structure of the application. Everything is handled in the
workbench.

To export your EAR file:
1. Return to the workbench.
2. In the WebFacing perspective, click File from the workbench menu.
3. Click Export on the pop-up menu.
The Select page of the Export wizard opens.
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Select

Export an Enterprise Application project into an EAR file /-‘

Select an export destination: [%

LEdapp Clisnt 18R file
L3t Deployable Features

5 able plug-ins and Fragments
L
em

-

fieFTP

18R file

2 Javadoc

‘p Project Interchange
BIRAR file
+“*Remote file system
(h+Remate JAR file
.,OfSyrnptnm database file
9 Team Project Set
10 WAR File

dWeb Service
Eziprie

e Back Next = Finish | Cancel I

4. Select the EAR file icon.

An EAR file is a compressed Enterprise Application Archive, and it contains all
the files needed for the Web application.

5. Click Next.
The EAR Export page opens.
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@ Export x|
EAR Export
Export Enterprise Application project to the local file system,

EAR project: | wflabxxEAR ~]
Destination: IE:'l,LIseafData'tWebSphere'l,.ﬂppServer'l,\v'ﬁIBase\profi[eskwasﬁexpr LI Bmwse.'.l

[~ Export source files
[¥ Overwrite existing file
[ Include project build paths and meta-data files

If you select this option, the exported EAR maintains project names and external
classpath dependencies, which are useful For later importing the EAR into binary
prajects, If you select this option and later import the EAR, only binary projects
are created,

< Back | [Mext = I Finish Cancel I

6. Select the name of the resources you used when creating your WebFacing
project. This should be wflabxxEAR from the Enterprise Application project
name list.

7. In the Destination field, specify where you want to put the EAR file by
entering the drive and directory structure of the IFS drive you mapped in the
steps before. For example, use the default directory structure for installable
applications for WebSphere Application Server Express:

x:UserData\Websphere\AppServer\V6\Base\profiles\was6express\installableApps

where x: is the drive letter mapped from your iSeries host in the previous
steps.

8. Select the Overwrite existing files without warning check box.
9. Click Finish.

If you see a message asking you to create a directory or delete an existing file,
Click OK or Yes and continue. Now you can install the application in
WebSphere Application Server.

You have exported the EAR file and now you are ready to begin |“Exercise 12.3:

[nstalling the application.”|

Exercise 12.3: Installing the application

Before iou begin, you must complete [“Exercise 12.2: Exporting your EAR file” on|
page 128,

At this point, you already need to have set up and started the WebSphere
Application Server and an associated HTTP server on your iSeries server. You also
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need to find the port number of the HTTP servers Administrative Console (referred
to as port#a) and the port number to run your application (referred to as port#b)
The second one is the port number of your HTTP server that is set up to work
with your application server.

To install the application:

1. Open any Web browser and type: http://servername:port#a/ in the Address
field.

Note: The default administrative port number for the HTTP server is 2001.
The Login dialog appears.

2. Type your iSeries user ID in the user ID field.

3. Type your iSeries password in the password field.

4. Click OK.
The browser opens.

IBM. C Qe i
iSeries Tasks =
() EBM Corporstion 2000 TORASLP3 TOROLABIBM.COM
38 ) IBM HTTP Server for iSeries
IBM WehSphere Application Server - Express for iSeries
Configure application servers and deploy applications
& | Digital Certificate Manager
o Create, distribute, and manage Digital Certificates
' IRM IPP Server for iSeries
Configure the IBM IFP Server
P #” Bl 4758 Cryptographic Coprocessor
i I Configure the 4758 coprocessor
Related task information G
Help
(Fequires JavaSaipt)

5. Click IBM HTTP Server for iSeries from the iSeries Tasks menu.

The Administration pages for the HTTP and application servers display.
6. Select the Manage tab then the Application Servers tab.

The Manage Application Server — Express page displays.
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7.

8.

9.

10.

11.

IBM Web Administration for iSeries
Setup BoEIEVEE Advanced | Related Lir
All Servers | HTTF Servers  Application Servers  ASF Tomcat Servers

@ Stopped Ferver:|defaulb’server1 -VB.0 = I

 Common Tasks and Wizards 21 defaultiserver]
J Create HTTP Server
J Create Application Server

¥ Migraie Originl 1o Apachs Manage WebSphere Application Server - V6.0

&7 WebSphere

|

J Create WebSphere Portal Profile: default Server default'server?
v WAS Wizards X )
J Install New Application No description for server default/serverl

J Create JDBC Provider £

J Create Dala Source 53 i -§!:| e ¥ {El: D=3 4 =
J Deploy 1BM Telephone Director L ; :

J Deploy IBM Survey Creatar Create Additional Install New Application Create Data Source
Virtual Host

Select your WebSphere Application Server Express server instance from the
Server list.

Click Install New Application in the right pane.
The Install New Application page displays.

defaultiserver] = Install Mew Application &

Install New Application @
Specify Application Location

Welcome to the Install New Application wizard. This wizard will install an application into this WebSphere
Anplication Server. The application must already exist on the iSeries server in an integrated file system directory.

O\pplicah‘un is contained in an EAR file

Integrated file system path of EAR file: |/QIBM/UserData/WebSphere/AppServerVe/Baselprofiles, | Browse |@

Note: The file must already be on the iSeries. T

fl" Application is contained in 2 WAR file | __|;‘
4 »

|Em Next i(:am:el-|
=
Click the Application is contained in an EAR file radio button.

Specify the location of your EAR file; (the file that you exported in the
previous step).

You can use the Browse push button to locate the file.
Click Next.

A page appears with options for application installation.
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defauliserver] = Install New Application

Install New Application @
Frovidde Options to Perform the install

Specity application deployment options

Application name: |wﬂabxx| )
Directory application installed to: /QIBM/UserDataMiebSpheralappServervBiBaselprofilesidefaulinstalledApps

€ re-compite Jsps @

Note: Pre-compiling JSPs can have significant performance impacis. When enabled, the JSPs in the
application will be compiled at installation time, causing the application install to take longer. When disabled,
the JSPs will be compiled the firsttime they are accessed, causing the first use of the application to take longer.

Back | Next | | Cancel

12. In the Application name field, type wflabxx.

13. You can select the Pre-compile JSPs check box to speed up the process of
showing the page the first time. (JSPs are compiled into Servlets when first
generated.)

14. Click Next.
The Map Virtual Hosts Page appears.

defaultiservert = Install New Application

Install New Application @
Map Virtual Hosts for Web Modules

Specify the virtual hostyou want to associate with the web modules contained in this application. Web modules can
be installed on the same virtual host or dispersed among several virtual hosts.

Map web modules to virual hosts: &
[ Web module Virtual host

Back || Nz{% | Cancel |

15. Select the virtual host to be associated with the Web module.

16. Select a virtual host of your choice, or leave the default host selected.
17. Click Next.
The application summary page displays.
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defaultserver] = Install New Application

Install New Application @
Sumrnany

YWhen you click Finish the installation will be started for the following application.

Integrated file system path of EAR file:
Application name:

Directory application installed to:
Pre-compile JSPs:

mipMnserDataMiebSphere/AppServeryB/Baselprofilesh e
whlakno
meMserDataMiebSpherelAppServenviiBaselprofilesidefaultinstalledApps
Enabled

Map web modules to virtual hosts:

Web module

Virtual host

wilaknod

default_host

4

|' Back | Finish | _t:ancel_'

18. Click Finish.

|

After the successful installation you see a page where you can manage the

installed applications.

@ Stopped

w Common Tasks and Wizards
J Create HTTP Server
J Create Application Server
J Migrate Original to Apache
J Create WebSphere Portal

-~

- WAS Wizards
J Install New Application
J Create JOBC Provider
J Create Data Source
J Deploy IEM Telephone Directon
J Deploy IBM Survey Creator

w Sewer Properties
[ Berver Tracing
B Server Ports
O View HTTP Servers

¥ Applications
B Manage Installed Applications

ster.ldefauhfsenter‘l -VB.0

ion
ts

w Resource Config
B Manage Virtual

=
defaultiservert

Manage WebSphere Application Server - V6.0
Profile: default Sewer defaultiserver!

No description for server default/server

['%]ﬂ S ama g

Create Additional Virtual Host
The default virtual host
"default_host" was created for this

Install New Application
After creating the server and virtual
host you can install your

application server. However, you applications.
can specify additional virtual hosts
for more control over what URI's
can run which applications.
Current Configuration  Profile: "default™ Server"(

Manage Installed

Manage Virtual Hosts Applications

19. Click Manage Installed Applications under Applications.
A page with the installed applications displays.
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defauli’server! = Manage Installed Applications
Manage Installed Applications @
Data current as of Mar 24, 2005 6:26:48 PM.

Installed applicaiinns:@

Application name Status Enahlement
@ wilabxx © Stopped  Enabled
¢ DefaultApplication e Stopped  Enabled
C query € Stopped  Enabled
o iApp © Stopped  Enabled
Install| [ Start| [ Propetties| [ Uninstall || Update | | Refresh
| Close

20. Click the wflabxx radio button in the list of installed applications.

21. If the wflabxx application is disabled, click the Properties push button to
enable the application.

defaultfserver! = Manage Installed Applications = Application Properties
Application Properties @

General \firtual Host Mapped to Web Modules

Location: 1alBMiUserDatadebSphereffppServervVE/BaselprofilesidefaultinstalledApps @

b

OK | apply| | Cancel |

22. Select Enabled from the Application enablement list.
23. Click OK.

Next you start the application with wflabxx in the enabled state.

Chapter 12. Module 12. (Optional) Exporting to iSeries WebSphere Application Server Express 6 135



defaultiserver! = Manage Installed Applications
Manage Installed Applications @
Data current as of Mar 24, 2005 6:31:01 PM.

Installed applicaiions:@

Application name Status Enablement
@& wilabxx e Stopped  Enabled
¢ DefaultApplication (C} Stopped  Enabled
© query @ Stopped  Enabled
 itApp € Stopped  Enabled

Install || Start | § | Properties | | Uninstall || Update | | Refrash

| Close

24. Click the wflabxx radio button.

25. Click Start.
If the Start button is not enabled, start the server first.
Now you are ready to test your WebFacing application.

You have started the existing HTTP server, installed and managed the application

and now you are ready to begin [“Exercise 12.4: Testing the WebFacing]|

Exercise 12.4: Testing the WebFacing application

Before you begin, you must complete [“Exercise 12.3: Installing the application” on|
ia ge 130.

To test the Web application:

1. Open the Internet Explorer and type Http://servername:port#b/wflabxx in the
Address field.

Note: This is the HTTP port name, most likely 80, not the application bootstrap
port.

Your application index.jsp page should open. If it does not, double-check the
URL and the port number. Also try restarting the HTTP server and the
application server. Refer to the Administrative Console Web site if you are
having problems starting and running the HTTP server or the WebSphere
Application Server. If you still encounter problems, there are troubleshooting
guides, FAQs, and newsgroups on the Web where you can find an explanation
of your situation with more detailed information.

You have run the application.

Module recap

You have completed [Chapter 12, “Module 12. (Optional) Exporting to iSeries|
[WebSphere Application Server Express 6,” on page 127]You have learned how to:

* Map a network drive
* Open the Export wizard
* Export the EAR file
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* Start an existing HTTP server console
* Install and manage the application
* Run the application on the production server

Finish your tutorial by reviewing the materials in [Chapter 13, “Summary,” on page
139.
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Chapter 13. Summary

This tutorial has taught you how to convert the DDS screens in an existing 5250
order entry application to a Web browser user interface. While creating a browser
user interface, you learned how to use the IBM WebFacing Tool. You also learned
how to customize the output of the conversion process using the IBM WebFacing
Tool and the CODE Designer. Finally, you learned how to run the WebFacing
application in the WebSphere Test Environment that is part of the product.

If you have completed all of the modules, you should now be able to:

* Create a WebFacing Web Project

e Convert one or more DDS and UIM files

* Run the application in the WebSphere Test Environment

* Customize the WebFacing application

* Secure your application by forcing authentication before the application is called
* Make the input page of the application more interesting

* Deploy the WebFacing application to a production server (optional)

More information

For more information on the product and the IBM WebFacing Tool, see
http:/ /ibm.com/software/adwtools/iseries.
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Appendix. Notices

Note to U.S. Government Users Restricted Rights — Use, duplication or disclosure
restricted by GSA ADP Schedule Contract with IBM Corp.

This information was developed for products and services offered in the U.S.A.
IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user’s responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not give you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
US.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing

2-31 Roppongi 3-chome, Minato-ku
Tokyo 106-0032, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.
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IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

Lab Director

IBM Canada Ltd. Laboratory
8200 Warden Avenue
Markham, Ontario

Canada

L6G 1C7

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this information and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement, or any equivalent agreement
between us.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

Each copy or any portion of these sample programs or any derivative work, must
include a copyright notice as follows:

© (your company name) (year). Portions of this code are derived from IBM Corp.
Sample Programs. © Copyright IBM Corp. 1992, 2005. All rights reserved.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.

Programming interface information

Programming interface information is intended to help you create application
software using this program.

General-use programming interfaces allow you to write application software that
obtain the services of this program’s tools.
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However, this information may also contain diagnosis, modification, and tuning
information. Diagnosis, modification and tuning information is provided to help
you debug your application software.

Warning: Do not use this diagnosis, modification, and tuning information as a
programming interface because it is subject to change.

Trademarks

CUA

IBM
iSeries
0S/400
Rational
WebSphere

Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Sun Microsystems, Inc. in the United States, other countries, or both.

ActiveX, Microsoft, SourceSafe, Visual C++, Visual SourceSafe, Windows, Windows
NT®, Win32, Win32s and the Windows logo are trademarks of Microsoft
Corporation in the United States, other countries, or both.

UNIX® is a registered trademark of The Open Group.

Other company, product, and service names may be trademarks or service marks
of others.
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